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About this Guide

This guide contains the webMethods BPM Process Simulation Help in PDF book format.
The information in this guide is the same information that you can view via the
Software AG Designer online help.

Document Conventions

Convention Description

Bold Identifies elements on a screen.

Narrowfont Identifies storage locations for services on webMethods
Integration Server, using the convention folder.subfolder:service .

UPPERCASE Identifies keyboard keys. Keys you must press simultaneously
are joined with a plus sign (+).

Italic Identifies variables for which you must supply values specific to
your own situation or environment. Identifies new terms the first
time they occur in the text.

Monospace
font

Identifies text you must type or messages displayed by the
system.

{ } Indicates a set of choices from which you must choose one. Type
only the information inside the curly braces. Do not type the { }
symbols.

| Separates two mutually exclusive choices in a syntax line. Type
one of these choices. Do not type the | symbol.

[ ] Indicates one or more options. Type only the information inside
the square brackets. Do not type the [ ] symbols.

... Indicates that you can type multiple options of the same type.
Type only the information. Do not type the ellipsis (...).
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Online Information
Software AG Documentation Website

You can find documentation on the Software AG Documentation website at hp://
documentation.softwareag.com. The site requires Empower credentials. If you do not
have Empower credentials, you must use the TECHcommunity website.

Software AG Empower Product Support Website

You can find product information on the Software AG Empower Product Support
website at hps://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability,
and download products, go to Products.

To get information about fixes and to read early warnings, technical papers, and
knowledge base articles, go to the Knowledge Center.

Software AG TECHcommunity

You can find documentation and other technical information on the Software AG
TECHcommunity website at hp://techcommunity.softwareag.com. You can:

Access product documentation, if you have TECHcommunity credentials. If you do
not, you will need to register and specify "Documentation" as an area of interest.

Access articles, code samples, demos, and tutorials.

Use the online discussion forums, moderated by Software AG professionals, to
ask questions, discuss best practices, and learn how other customers are using
Software AG technology.

Link to external websites that discuss open standards and web technology.

http://documentation.softwareag.com
http://documentation.softwareag.com
https://empower.softwareag.com
https://empower.softwareag.com/Products/default.asp
https://empower.softwareag.com/KnowledgeCenter/default.asp
http://techcommunity.softwareag.com
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Simulating a Process
The webMethodsProcess Simulation feature for Software AG Designer provides a
mechanism to simulate processes and observe how they run. By simulating a process,
or multiple processes, you can save time, energy, and resources that might otherwise
be misspent on deploying solutions that do not fit your business needs. Simulation
provides the opportunity for testing and fine-tuning processes in the design phase,
before they ever reach production, or even a test environment.

Simulation enables you to:

Discover process bolenecks

Predict process behavior in multiple scenarios

Learn about total process cost

Understand process resource utilization, including consumables and non-
consumables

Compare the behavior (performance, utilization, cost, etc.) of two or more different
processes, or of two or more versions of the same process

Optimize processes

Determine how processes actually work under real-world conditions

With a greater depth of process knowledge and behavior, you can make informed
iterative changes until you reach the desired simulated result, and ultimately deploy the
final version of the process to a production environment.

Process simulation requires webMethodsProcess Development, which has its own help
set. For general information about working with processes, see the webMethods BPM
Process Development Help.

Process simulation is covered in the following main topics:

"About Simulation Information" on page 9

"Configuring Process Simulation Preferences" on page 11

"About Process Simulation Views" on page 13

"Working with a Process Simulation" on page 44

"Configuring a Process Simulation" on page 51

"Running a Process Simulation " on page 68

" Process Simulation Reporting" on page 69

" Process Simulation Recording and Playback" on page 95

" Process Simulation Performance Seings" on page 96
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About Simulation Information
To successfully simulate a process, you must specify various kinds of information
that represent the data and conditions that the process would normally work with
when it is implemented in the run-time environment. The more accurately you define
this information, the more accurate your simulations will be. You can configure your
simulations to use historical data from real processes (where available), and you can also
set various preferences that define the behavior of a simulation as it runs.

You can create a simulation directly from an open process, or you can create a new
simulation file and then add one or more processes to it.

You can also create a simulation from an imported XPDL process, and you can create a
simulation while importing if the XPDL file contains simulation information. For more
information, see "Importing XPDL Processes" in webMethods BPM Process Development
Help, and "Running a Process Simulation " on page 68.

After you have run a simulation, you can generate a simulation report that captures
detailed information about the scenario simulated, and whose data allows you to create
charts, graphs, and other materials based on the results of the simulation. For more
information, see " Process Simulation Reporting" on page 69.

Note: Designer does not extract metadata for simulations. Simulations do not
have references or dependencies. You cannot publish or retract simulation
metadata.

The simulation information you define is described in the following topics:

"About Scenarios" on page 9 describes simulation scenarios and their contents.

"About Resources" on page 10 describes the various kinds of simulation
resources and their definition.

"About Costs" on page 10 describes the various kinds of costs associated with a
resources and their definition.

For a general description of the Process Simulation perspective and the views it contains,
see "About the Process Simulation Perspective" on page 12.

About Scenarios
To transform your business process to a simulation you must first define a scenario of
aributes for the process. Seing up your scenario for the process model enables you
to create a test case for how a process or set of processes will function with particular
constraints.

A scenario is defined by:

The frequency and the interval of business process instances.

The length of time each step may be actively processing.
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Any resources that your process may use to execute its steps.

By creating scenarios from existing criteria within your business, you can closely model
the behavior, efficiency, and results of your process models. Analyzing output from
simulations enables you to:

Increase service level

Reduce total process cycle time

Increase throughput

Reduce waiting time

Reduce process cost

Reduce inventory costs

About Resources
A resource can be consumable or non-consumable. Examples of consumable resources
are equipment or supplies such as trucks and gasoline. Examples of non-consumable
resources would be a salaried employee or a hired consultant.

Resources are defined on a per-simulation basis and are available for all processes
within a simulation, meaning that a single resource pool is shared by all the processes.
This enables a more sophisticated comprehension of resource contention across a set of
processes in an enterprise.

Resources are defined by the units allocated for the resource and the units acquired by a
particular process step. When a consumable resource is acquired by a step, the resource
is removed from the set of allocated resources. When a non-consumable resource, such
as an office clerk, is acquired by a step, it is no longer available to other steps until the
processing of that step is completed. This means that if you have only one office clerk
and a step that requires the clerk is started, the next process instance that arrives at
that step will be queued for processing until the first instance requiring the clerk is
completed.

About Costs
Resources can also have cost aributes:

A fixed cost for any use that is not based on time.

OR

A fixed cost per time period.

OR

A variable cost per time period which is associated with non-consumable resources,
or a variable cost without a time period which is associated with consumable
resources.
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Some examples of cost types:

Consumable resource with variable cost

Fuel is an example of a consumable resource with a variable cost. If fuel costs $3 a
gallon, $3 is its variable cost. Every time a unit (gallon) of fuel is used, a cost of $3 is
applied.

Non-consumable resource with variable cost per period

An employee paid hourly is an example of a non-consumable resource with a
variable cost per period. The employee's hourly pay may be defined as a variable
cost of $30 per hour.

Non-consumable resource with fixed cost

A salaried employee is an example of a non-consumable resource with a fixed cost.
The employee's annual salary may be defined as fixed cost of $30,000 yearly.

Configuring Process Simulation Preferences
In Designer's Process Simulation Preferences, you can set options for recording
animation, automatic switching to the Process Simulation perspective, and the types of
gauges displayed during an animated simulation. The Process Simulation control panel
provides additional options for viewing a running simulation, in real time or playback
mode.

Tip: You can run a simulation with animation and watch, record, and play back
the simulation, or you can run the simulation silently and send the results to
a report. Some simulations run for a long time, and live animation requires
processing power you may want to use elsewhere. Running the simulation in
the background and sending the results to a report enables you to continue
your work in Designer.

To configure Process Simulation preferences

1. In Designer: Window > Preferences >Software AG>Process Development>Process
Simulation

2. You can configure the following Process Simulation preferences:

Preference Description

Enable animation
recording

Check this box to enable Designer to record
simulation sessions for playback. Enabled by default.

Temp directory This option is only available when Enable animation
recording is enabled. Type or browse to select the temp
directory you want Designer to use to store animation
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Preference Description
recording files. The default path is the parent folder of
the currently selected workspace.

Switch to theProcess
Simulationperspective
when opening a
simulation file

Choose Always, Never, or Prompt. Default is Prompt.

Activity gauge type Choose Image Gauge or Bar Chart Gauge. Default is
Image Gauge. See "Step Gauges and Statistics" on page
93.

Note: Whether or not you set Designer to prompt you, automatic perspective
switching happens only when you open a process or process simulation
file. When you switch back and forth between a process and a process
simulation file after they have been opened, Designer does not change
perspective. This enables you to view a file in a different perspective than
its default.

3. To apply default preferences on a page, click Restore Defaults.

4. Do one of the following:

Click Apply to save your changes and keep the Preferences window open.

Click OK to save your changes and close the Preferences window.

Click Cancel to close the Preferences window without saving your changes.

Tip: You can use the Forward and Back buons in the Preferences window
to navigate through Preferences pages you have visited.

About the Process Simulation Perspective
The Process Simulation perspective provides several views that enable you to configure
your simulations and interpret their behavior:

The Resources view contains Resource and Cost information; these are displayed in
the Properties view for a selected resource.

The Run Seings view contains Run Seings and Statistics information.

The Advanced Run Seings view contains information about Variables, Historical
Data, and Optimization.

The Statistics view provides information about the number of completed, created,
and active instances, as well as time and cost averages.
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The Optimize Statistics view provides information about progress toward objectives,
as well as summary information.

For more information about these views, see "About Process Simulation Views" on page
13.

Additional step configuration is supported in the Properties view for various step types.
The Schedule, Scenario, Metrics, and Transition Distribution pages enable you to finely tune
your simulations. See "Configuring a Step Simulation" on page 58.

About Process Simulation Views
The  Process Simulation perspective includes functionality that enables simulation
of processes, including advanced resource configuration and run seings, animation,
statistics, and reporting. It includes the simulation-related Resources view, Run Seings
view, Advanced Run Seings view, Statistics view, and Optimize Statistics view. The
Run Seings view contains tabs with seings for Run Seings and Statistics; and the
Advanced Run Seings view contains tabs with seings for Variables, Historical Data,
and Optimization.

The Process Simulation perspective and its views are made available when you install
the Process Simulation feature.

You can configure Designer preferences to automatically switch to the Process
Simulation perspective when you open a simulation file. See "Configuring Process
Simulation Preferences" on page 11. You can also configure automatic switching to
the Process Development perspective when you open a process file. See "Appearance
Preferences" in webMethods BPM Process Development Help.

Note: Whether or not you set Designer to prompt you, automatic perspective
switching happens only when you open a process or process simulation file.
When you switch back and forth between a process and a simulation file after
they have been opened, Designer does not change perspective. This enables
you to view a file in a different perspective than its default. The Process
Simulation feature is required to view simulation files. See "About Simulation
Information" on page 9.

The Process Simulation perspective also contains some views also displayed in the
Process Development perspective.

Properties View

The Properties view displays information about the currently selected asset in Designer,
including processes, steps, pools, transitions, annotations (notes), and simulation
resources. Based on the type of asset selected, the Properties view is organized into
pages that allow you to see and configure specific aspects of the asset.

Basic and advanced information pages in the Properties view is included in the
Process Debug and Process Simulation perspectives; the Process Development
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perspective displays advanced properties information only when the Advanced Process
Development capability is enabled.

Note: By default, the Advanced Process Development capability is enabled.
Designer displays advanced properties in the Properties view, advanced
preferences in the Preferences window, and advanced functions on the main
toolbar. To see only basic properties, preferences, and functions, you must
disable the Advanced Process Development capability preference in Window >
Preferences > General > Capabilities. See "Capabilities Preferences" in webMethods
BPM Process Development Help.

If you close the Properties view and want to reopen it, select Window > Show View > 
Properties.

Outline View

The Outline view is a standard Eclipse view. In Designer, it provides a tree view of the
elements in the currently open simulation editor. Use it to locate elements on the canvas.
This is especially helpful when the canvas contains many elements. When you select
an element in the Outline view, it becomes the selected element on the canvas. As a
result, other views that are specific to the selected element, such the Properties view,
also display information for the selected element.

If you close the Outline view and want to reopen it, select Window > Show View > 
Outline.

Use the Add Process, Remove Process, and Refresh Processes buons to manage
the processes in a currently open simulation file.

Navigator View

The Navigator view is a standard Eclipse view that provides a tree view of all the assets
in your workspace. You can use the Navigator view to open files for editing or select
assets for operations such as exporting. If you are using Team Development, use the
Navigator view to share assets in your workspace with other team members. For more
information about using the Navigator view or Team Development, see the Eclipse
Workbench User Guide documentation.

If you close the Navigator view and want to reopen it, select Window > Show View > 
Navigator.

Note: An alternative to viewing your workspace using the Navigator view is to use
the webMethods-provided Solutions view. In the Navigator view, the tree
structure lists files that are in your workspace. The Solutions view provides a
simpler view that shows only your webMethods assets. In the Solutions view,
the tree structure lists only the assets (for example, processes, simulations,
tasks, and user interfaces) and not the individual files that make up those
assets.

Solutions View
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The Solutions view shows webMethods assets in your workspace; that is, it shows
processes, simulations,webMethods rules, user tasks, and user interfaces. Assets are
grouped by solution, which is a logical grouping you can form to relate the processes,
simulations, webMethods rules, user tasks, and user interfaces that you use for a
solution. This allows you to visually comprehend all the assets that make up one of your
solutions.

You can adjust and update the Solutions view tree using the Collapse All and
 Refresh buons on its toolbar. You can also  Import and Export files in the

Solutions view.

If you close the Solutions view and want to reopen it, select Window > Show View >
 Solutions.

 Problems View

The Problems view is a default Eclipse view that displays system-generated errors,
warnings, or information associated with a resource. For example, if a receive task in
your process does not have a subscription document specified, the error is automatically
logged in this view. The Problems view also displays errors and warnings generated by
Simulation.

If you close the Problems view and want to reopen it, or if you want to open it in another
perspective, go to Window > Show View >  Problems.

For more information on Process Development views and perspectives, see ”Process
Development Help” in webMethods BPM Process Development Help.

About the Resources View
The  Resources view is displayed in the Process Simulation perspective. You use the
Resources view to configure the resources (consumable and non-consumable) used in
simulations.

Note: If a simulation is not open in the editor, the view displays the message,
“Resource view is not available.” Open a simulation to view its resources.

If you close the Resources view and want to reopen it, select Window > Show
View > Resources.

The following tool bar buons are available in the Resource view:

Add resource to simulation

Import resources from other simulations

Remove resource from simulation

After you have defined the resources for a simulation, you then configure the steps in
the simulation to use them. For more information, see "Configuring a Step Simulation"
on page 58.
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The Resources view contains a list of all the resources defined for a simulation. By
default, resources are initially named Resource1, Resource2, and so on. You can
change the name of a resource on the Properties view. You can configure the following
properties for a selected resource:

On the Resource page in the Properties view:

Field Description

Name Unique resource name. Default is Resource1, Resource2, and
so on.

Description Optional description of the resource.

Available Units How many units of the resource are available overall. Do one
of the following:

Enter a static numeric value.

Click the browse buon  to open the Available Units
dialog box for the selected resource. You can enter a
constant or a variable, or select a distribution:

Click Constant to enter a static numeric value in the
Constant field. This is the same as entering the value
in the Available Units field on the Resource page of the
Properties view.

Click Variable to use historical data or an optimized
variable. Enter a Variable Name and a Default Value.
Further configuration of variables is available on the
Variables tab in the Advanced Run Seings view.

Click Distribution to select a distribution. You can select
from the list and modify the available parameters.

After you define your configuration, click Finish.

Note: Descriptions of available distributions are provided in
the selection dialog box and in "Distribution Reference"
on page 19.

On the Cost page in the Properties view:

Field Description

Consumable
Resource

Select this check box if the resource is consumable.

A consumable resource loses a portion of its available
units when it is allocated to a step. For example, fuel is a



M
Odd Header

About Process Simulation

webMethods BPM Process Simulation Help Version 9.8 17

Field Description
consumable resource. An example of a resource that is not
consumable is an employee.

When you indicate that a resource is consumable, the Fixed
Cost option is removed. You can set Usage Cost and Variable
Cost without a per period value .

Note: For non-consumable resources, you can set Usage Cost,
Fixed Cost, and either Variable Cost per period or Variable
Cost without a per period value.

Usage Cost Usage costs include "fixed fee" charging schemes such as
administrative or service call charges. The same cost is
applied regardless of the amount of the resource's capacity or
the step's processing time. Do one of the following:

Enter a static numeric value.

Click the browse buon  to open the Usage Cost dialog
box for the selected resource. You can enter a constant or a
variable, or select a distribution:

Click Constant to enter a static numeric value in the
Constant field. This is the same as entering the value in
the Usage Cost field on the Cost page of the Properties
view.

Click Variable to use historical data or an optimized
variable. Enter a Variable Name and a Default Value.
Further configuration of variables is available on the
Variables tab in the Advanced Run Seings view.

Click Distribution to select a distribution. You can select
from the list and modify the available parameters.
Descriptive text for each distribution type is shown
on the Usage Cost dialog box and in "Distribution
Reference" on page 19.

After you define your configuration, click Finish.

Variable Cost Variable cost is based only on the amount of the resource's
capacity. Do one of the following:

Enter a static numeric value.

Click the browse buon  to open the Variable Cost
window for the selected resource. You can enter a constant
or a variable, or select a distribution:

Click Constant to enter a static numeric value in the
Constant field. This is the same as entering the value in
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Field Description
the Variable Cost field on the Cost page of the Properties
view.

Click Variable to use historical data or an optimized
variable. Enter a Variable Name and a Default Value.
Further configuration of variables is available on the
Variables tab in the Advanced Run Seings view.

Click Distribution to select a distribution. You can select
from the list and modify the available parameters.
Descriptions of available distributions are provided in
the selection window and in "Distribution Reference" on
page 19

After you define your configuration, click Finish.

per Period Optional. When set, variable cost calculation takes into
account the amount of the resource's capacity and the time
used. Select Milliseconds, Seconds, Minutes, Hours, Days, Weeks,
Months, or Years. No default value is set.

Note: The per Period option is not available for consumable
resources.

Fixed Cost This option is available only for non-consumable resources.

A fixed cost is neither variable nor usage-based. Do one of
the following:

Enter a static numeric value.

Click the browse buon  to open the Fixed Cost dialog
box for the selected resource. You can enter a constant or a
variable, or select a distribution:

Click Constant to enter a static numeric value in the
Constant field. This is the same as entering the value in
the Fixed Cost field on the Cost page of the Properties
view.

Click Variable to use historical data or an optimized
variable. Enter a Variable Name and a Default Value.
Further configuration of variables is available on the
Variables tab in the Advanced Run Seings view.

Click Distribution to select a distribution. You can select
from the list and modify the available parameters.
Descriptions of available distributions are provided in
the selection window and in "Distribution Reference" on
page 19.



M
Odd Header

About Process Simulation

webMethods BPM Process Simulation Help Version 9.8 19

Field Description

When you have defined the configuration you want:

Click Finish.

Select the time basis or cost period frequency of the fixed
cost. Options are Weekly, Monthly, Quarterly, Half-Yearly, and
Yearly. Default is Quarterly.

Downtime Profile Select the profile that best describes the hours during which
the activities in your simulation will take place:

No downtime (selected by default).

Standard shift (includes a downtime schedule that causes a
resource to be available only from 8am-12 noon and 1-5pm,
Monday-Friday)

Night shift (includes a downtime schedule that causes a
resource to be available only from 11pm-3am and 4-8am,
Monday-Friday).

Distribution Reference
Designer enables you to select from a list of distribution types when you configure
a simulation resource distribution in the Properties view, and when you configure a
simulation step scenario in the Properties view. The following distribution types are
available:

Note: The descriptions below are also available in the Usage, Variable, and Fixed
Cost dialog boxes when you configure a resource in Designer:

Distribution Description

Constant A static numeric value.

Poisson The Poisson distribution (discrete) with mean = m is the
distribution of the number of customers that arrive to some
system in any time interval of length 1 when the interarrival
times have an exponential distribution (continuous) with
mean = 1/m. Mean must be greater than 0.0.

Exponential The exponential distribution (continuous) is commonly used
to model interarrival times of customers to some system
when the arrival rate is approximately constant over the
time period of interest. It is also sometimes used to model
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Distribution Description
the time to failure of a piece of equipment. The mean of an
exponential distribution is a scale parameter and must be
greater than 0.0. An exponential distribution with mean =
m is a gamma distribution with mean = m and shape = 1.
An exponential distribution with mean = m is a Weibull
distribution with shape = 1 and scale = m. If interarrival times
of customers have an exponential distribution with mean =
m, then the number of arrivals in any time interval of length t
has a Poisson distribution (discrete) with mean = t/m.

Normal (non-
negative)

This distribution is similar to the classical normal
distribution, but if a negative value is generated, it is rejected
and new values are generated until a non-negative value is
generated. In general, this distribution will not be a good
model for the time required to perform some task, since task-
time distributions are almost always skewed to the right.

Normal
(unbounded)

This is the classical normal distribution, which is found in
most statistics books. It takes on real values between minus
infinity and plus infinity. The density function is the familiar
"bell-shaped" curve, which is symmetric about the mean.
The probability that a value is between the mean minus
2 standard deviations and the mean plus two standard
deviations is approximately 0.95. This distribution should
not be used to model the time required to perform some task,
since the normal distribution can take on negative values.
Furthermore, as stated above, the distribution of the time
to perform some task is almost always skewed to the right,
rather than being symmetric.

Lognormal The lognormal distribution could be used to model the
time required to perform some task when "large" values
sometimes occur. It is always skewed to the right and it has
a longer right tail than the gamma or Weibull distributions.
The lognormal distribution is closely related to the classical
normal distribution - see the book Simulation Modeling and
Analysis (Third Edition) by Law and Kelton (2000) for details.
Furthermore, the parameters of the lognormal distribution,
namely, mean and standard deviation, correspond to
the lognormal distribution and are not the mean and
standard deviation of the corresponding normal distribution.
Parameter restrictions are mean > 0.0 and standard deviation
> 0.0.
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Triangular The triangular distribution (continuous) is typically used
as a rough model for the time required to perform some
task when no real-world data are available. A triangular
distribution takes on values in the finite interval [minimum,
maximum] (minimum >= 0.0, mode > minimum, and
maximum > mode), with values near the mode being most
likely to occur. Subjective estimates of the three parameters
are obtained from subject-maer experts. The mean of a
triangular distribution is only equal to the mode when the
distribution is symmetric.

Uniform The uniform distribution (continuous) is equally likely to
take on any real number in the finite interval [minimum,
maximum] (minimum >= 0.0 and maximum > minimum).
The real numbers produced by a random-number generator
(appear to) have a uniform distribution on the interval [0, 1].

Gamma The gamma distribution (continuous) could be used to
model the time required to perform some task. If a gamma
distribution has parameters mean = m and shape = a, then b
= m/a is a scale parameter. A gamma distribution with mean
= m and shape = 1 is an exponential distribution with mean =
m. When shape is a positive integer, the gamma distribution
is an Erlang distribution. Parameter restrictions are mean >=
0.0 and 0.0 < shape < 100.0.

Beta The beta distribution (continuous) could be used to model
the time required to perform some task when the possible
values are restricted to the finite interval [minimum,
maximum] (minimum >= 0.0, maximum >= 1.0, and
maximum > minimum). Parameter restrictions for shape1
and shape2 are shape1 >= 0.0 and shape2 > 0.0. The density
function is skewed to the left, symmetric, or skewed to the
right if shape1 > shape2, shape1 = shape2, or shape1 < shape2,
respectively. A beta distribution with shape1 = shape2 = 1 is a
uniform distribution with the interval [0, 1].

Erlang The Erlang distribution (continuous) could be used to
model the time required to perform some task. If an Erlang
distribution has parameters mean = m and shape = a, then
b = m/a is a scale parameter. An Erlang distribution is just
a gamma distribution whose shape parameter is a positive
integer. The sum of k exponential random variables with
mean = m is an Erlang distribution with mean = km and
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shape = k. Parameter restrictions are mean >= 0.0 and 0.0 <
shape < 100.0.

Weibull The Weibull distribution (continuous) could be used to
model the time required to perform some task. It is also
sometimes used to model the time to failure of a piece of
equipment. A Weibull distribution with parameters shape =
1 and scale = b is an exponential distribution with mean = b.
The Weibull distribution is skewed to the left when shape >
3.6. Parameter restrictions are shape >= 0.0 and scale > 0.0.

Hyper Exponential The hyper exponential distribution (continuous) is a mixture
of two exponential distributions. Specifically, a hyper
exponential distribution with parameters mean1, mean2, and
probability1 takes on values from an exponential distribution
with parameter mean1 with a probability of probability1
and takes on values from an exponential distribution with
parameter mean2 with a probability of 1 - probability1.
A hyper exponential distribution with probability1 = 1
is an exponential distribution with parameter mean1.
Parameter restrictions are mean1 >= 0.0, mean2 > 0.0, and 0.0
<= probability1 <= 1.0.

Uniform Integer A uniform integer distribution (discrete) is equally likely
to take on any integer in the finite interval [minimum,
maximum], where minimum and maximum are integers with
minimum >= 0 and minimum < maximum.

Geometric The geometric distribution (discrete) with probability =
p can be thought of as the distribution of the number of
failures before the first success in a sequence of independent
Bernoulli trials, where success occurs on each trial with
a probability of p and failure occurs on each trial with a
probability of 1 - p.

Pareto The Pareto distribution (continuous) could be used to
the model interarrival times of customers (for example,
messages) when the traffic has burst-like behavior. The
mean and variance are finite only if shape > 2. Parameter
restrictions are location >= 0.0 and shape > 0.0.

Binomial The binomial distribution (discrete) with parameters trials =
t (a positive integer) and probability = p can be thought of as
the distribution of the number of successes in t independent
Bernoulli trials, where success occurs on each trial with
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a probability of p and failure occurs on each trial with a
probability of 1 - p. A binomial distribution with trials = 1 is
called a Bernoulli distribution with probability = p.

Negative Binomial The negative binomial distribution (discrete) with parameters
s (> 0.0) and probability = p can be thought of as the
distribution of the number of failures before the sth success
in a sequence of independent Bernoulli trials, where success
occurs on each trial with a probability of p and failure occurs
on each trial with a probability of 1 - p. A negative binomial
distribution with parameters s = 1 and probability = p is a
geometric distribution with probability = p.

Inverse Gaussian The inverse Gaussian distribution (continuous) could be used
to model the time required to perform some task. Parameter
restrictions are scale > 0.0 and shape > 0.0.

Inverted Weibull The inverted Weibull distribution (continuous) could be
used to model the time required to perform some task. The
mean and variance are finite only if shape > 2. If the random
variable X has an inverted Weibull distribution with location
= 0, scale = b, and shape = a, then Y = 1/X has a Weibull
distribution with scale = 1/b and shape = a. (The location
parameter is 0.) Parameter restrictions are scale > 0.0 and
shape > 0.0.

Johnson SB The Johnson SB distribution (continuous) could be used to
model the time required to perform some task when the
possible values are restricted to the finite interval [minimum,
maximum]. The density function is skewed to the left,
symmetric, or skewed to the right if shape1 > 0, shape1 =
0, or shape1 < 0, respectively. The Johnson SB distribution
is closely related to the classical normal distribution - see
the book Simulation Modeling and Analysis (Third Edition) by
Law and Kelton (2000) for details. Parameter restrictions are
shape2 > 0.0 and maximum > minimum.

Johnson SU The Johnson SU distribution (continuous) could be used to
model a random variable that can take on any value between
minus infinity and plus infinity. The density function is
skewed to the left, symmetric, or skewed to the right if
shape1 > 0, shape1 = 0, or shape1 < 0, respectively. The
Johnson SU distribution is closely related to the classical
normal distribution - see the book Simulation Modeling and
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Analysis (Third Edition) by Law and Kelton (2000) for details.
Parameter restrictions are scale > 0.0 and shape2 > 0.0.

Log-Logistic The log-logistic distribution (continuous) could be used to
model the time required to perform some task. The mean and
variance are finite only if shape > 2. Parameter restrictions are
scale > 0.0 and shape > 0.0.

Log-Laplace The log-Laplace distribution (continuous) could be used to
model the time required to perform some task. The mean and
variance are finite only if shape > 2. Parameter restrictions are
scale > 0.0 and shape > 0.0.

Pearson Type V The Pearson type V distribution (continuous) could be used
to model the time required to perform some task. The mean
and variance are finite only if shape > 2. The Pearson type V
distribution is closely related to the gamma distribution. See
the book Simulation Modeling and Analysis (Third Edition) by
Law and Kelton (2000) for details. Parameter restrictions are
scale > 0.0 and shape > 0.0.

Pearson Type VI The Pearson type VI distribution (continuous) could be used
to model the time required to perform some task. The density
function can take on a wide variety of shapes because it has
two shape parameters shape1 and shape2. The mean and
variance are finite only if shape2 > 2.The Pearson type VI
distribution is closely related to the beta distribution. See the
book Simulation Modeling and Analysis (Third Edition) by Law
and Kelton (2000) for details. Parameter restrictions are scale
> 0.0 and shape1 > 0.0.

Random Walk The random walk distribution (continuous) could be used
to model the time required to perform some task. Parameter
restrictions are scale > 0.0 and shape > 0.0.

About the Run Settings View
The  Run Seings view appears in the Process Simulation perspective. Use the Run
Seings view to configure the overall seings of a simulation.

If you close the Run Seings view and want to reopen it, click Window > Show View
> Run Settings.

You can configure the following fields:
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On the Run Settings tab:

Field Description

Period Select a Date Range or Duration in which to run your
simulation.

Tip: Date and time formaing are governed by your
operating system seings; examples are provided. If you
want to run Designer using a different locale, set your
system to the new locale, then restart the machine and
run Designer.

Start Click the calendar buon  and select a date, or type a
start date, and then (optionally) a start time. The default date
value is the creation date of the simulation, and the default
time value is 12:00:00 AM.

End Available only for the Date Range period. Click the calendar
buon  and select a date, or type an end date, and
then (optionally) an end time. The default date value is the
creation date of the simulation, and the default time value is
12:00:00 AM.

Duration Available only for the Duration period. Enter the amount
of time you want your simulation to run in months, days,
hours, minutes, and seconds. The default is 3 months.

Update Frequency Select the update frequency for the simulation run. Select
Milliseconds, Seconds, Minutes, Hours, Days, Weeks, Months, or
Years. The default value is Hours.

This seing specifies how often to refresh the animation and
write information to the simulation recording file. You are
advised to use the same value that is configured for the Time
Interval property on the Schedule page of the process start
step.

Tip: If you encounter performance issues while running a
simulation with animation, it may help to increase the
Update Frequency value or unit of measure. For example,
if it is set to Hours, try increasing the number of hours,
or changing the unit of measure to Days or Weeks.
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See "Configuring a Step Simulation" on page 58 and "
Process Simulation Recording and Playback" on page 95.

On the Statistics tab:

Field Description

Currency Name Type the name of the form of currency to be used in the
simulation. This value is used for reporting purposes only,
and is included in the simulation report and Statistics view.

Cost Period
Frequency

Select the cost period frequency of the simulation. Options
are Weekly, Monthly, Quarterly, Half-Yearly, and Yearly. The
default is Quarterly.

This seing controls how often resource costs are updated in
the Statistics view, and is used in aggregating resource costs
in the Simulation report.

For more information, see "About the Statistics View" on
page 35 and " Process Simulation Reporting" on page
69.

Simulation Time
Unit

Select the default time unit for the simulation clock:
Milliseconds, Seconds, Minutes, Hours, Days, Weeks, Months, or
Years.

The default value is Hours. Adjust this unit of measure to
be larger or smaller, depending on the length of execution
time you expect for the steps in the simulation (for example,
weeks or milliseconds).

Tip: The Simulation Time Unit controls the time period used
by the Process Simulation Engine when reporting cycle
time for steps, processes, and availability. Statistics
are collected at the specified unit of time. If you have
a process that starts a given number of times per week
and you set the Simulation Time Unit at one hour, Designer
collects data every hour. In the case of a long-running
simulation, this could be a waste of processing power.
For this reason, you are advised to use the same time
unit of measure that is configured for the step Processing
Time property on the Scenario page in the Properties
view.
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For more information, see "Configuring a Step Simulation" on
page 58.

About the Advanced Run Settings View
The  Advanced Run Seings view appears in the Simulation perspective. Use the
Advanced Run Seings view to configure variables, historical data, and optimization
seings. If you do not use variables, historical data, or optimization, you do not need to
use this view.

If you close the Advanced Run Seings view and want to reopen it, click Window > Show
View > Advanced Run Settings.

The Advanced Run Seings view contains three tabs:

The Variables tab. For more information, see "About the Variables Tab" on page
27.

When you use a variable data source, you must specify its default value. No further
configuration is necessary. The simulation replaces the variable with its default
value. A default value is useful if you want to quickly change the constant value of a
component property without navigating to the component and editing it there.

The Historical Data tab. For more information, see "About the Historical Data Tab" on
page 30.

A historical data source requires BPMS data extraction to calculate the value.
Simulation cannot run without the historical data from a historical data fit
distribution, because the variable has no value. For more information, see
"Configuring Your System to Use Historical Data" on page 53.

The Optimization tab. For more information, see "About the Optimization Tab" on
page 32.

An optimized data source requires running an optimization to obtain an optimal
value. Though it is possible to run an optimization with the default 0.0 value (if you
do not have optimization data), there is no benefit in doing this.

About the Variables Tab
The table on the Variables tab in the Advanced Run Seings view contains a list of all
variables defined on the simulation resource and step properties. You can add and
remove variables by editing the component property (such as a resource's fixed cost or a
step processing time).

The table is updated automatically whenever you add, change, or remove a variable by
editing the component property. If you edit a component property that uses a variable to
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use a constant instead, the table on the Variables tab no longer displays the variable, as it
is no longer used.

Each variable can be used by only one component property; thus, each variable can have
only one referenced component.

Though you cannot directly modify the variables using the table, you can control a
variable’s data source, which essentially sets the value of the variable to be used in
simulation of the process. When you configure a simulation scenario, you have the
option of defining the fixed cost of a resource to a variable (such as r1cost ), where the
r1cost  value is obtained through optimization (data source) and has a result of 200
(value). If historical data is available, you can use that data source.

The following information is listed for each Variable Name on the Variables tab:

Field Description

Referenced
Component

The Referenced Component of a variable is a combination of
the name of the component where the variable is and the
aribute type the variable has. This value is not editable.

For example, you might have a receive task called Receive
Task and set a variable for its Quantity on the Schedule page in
the Properties view. The Referenced Component name would
be Receive Task quantity.

Data Source The Data Source of the variable:

Default. The default value set for the variable.

Historical. Historical data: select where to get the value ( file
or BPMS). The value is <Not Yet Retrieved> until you select the
source.

Optimized. An optimized value: run an optimization to
populate the value. The value is 0.0 until you run the
optimization.

Value The Value column is populated after you specify the Data
Source information.

Important: This means that if you select a Historical Data Source,
you must retrieve the data before you see a value here.
If you select an Optimized Data Source, you must run an
optimization before you see a value here.

The column values are not editable.

Important: You cannot undo the Clear Values action described
below!
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To clear data values, click one of the following buons:

Clear Optimized Values

Clear Historical Data Values

Clear All Values

About Variables
Any field that has a browse buon  can be set as a variable. This includes:

Field Located

Available Units ... on the Resource page in the Properties view of a resource.

Variable Cost ... on the Cost page in the Properties view of a resource.

Fixed Cost ... on the Cost page in the Properties view of a resource.

Processing Time ... on the Scenario page in the Properties view of a step.

Tip: Spaces are not permied in variable names.

Variable values can be populated three ways:

Field Description

Default A default value set by the user.

Optimized A value calculated by running an optimization.

Historical A value calculated by gathering historical data.

Historical data values can be used for the following types of values:

Field Located

Quantity ... on the Schedule page in the Properties view of a start step.

The Quantity describes the number of instances to run at the
given Time Interval.
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Field Located

Time Interval ... on the Schedule page in the Properties view of a start step.

The Time Interval is the frequency at which the start step runs.

Processing Time ... on the Scenario page in the Properties view of a step.

The Processing Time is the amount of time it takes the step to
process.

Distribution ... on the Transition Distribution page in the Properties view of a
step.

The Distribution describes which transitions are taken in
which combinations from the step

Note: Historical data values can be used for any variable, but only the above listed
types of values are available from process audit and reporting data. If you
want to set variables on other types of aributes in the simulation (resources,
available units, costs, etc.), you must supply a tab-delimited data file from
which to create a distribution function.

Optimized values can be calculated for any variable other than transition distributions
for steps.

Important: If you are using Optimized or Historical Data variables, you must retrieve
the values you will use by running the optimization or historical data fit
distribution before you run your simulation. Default values are used if no
values have been retrieved.

For more information about using variables, see "Distribution Reference" on page 19.

About the Historical Data Tab
You can use historical data to create simulations based on real values from previous
process executions; this is done by finding a distribution function that fits a sample
of these values. Simulations that utilize historical data are often referred to as fit
distributions.

Historical data for a resource can be loaded from a tab-delimited file of values. Process
initiation frequency and volume, step duration, and transition path distributions can
either be imported from a tab-delimited file, or directly from data from the webMethods
BPMS reporting database.

Tip: Date and time formaing is governed by your operating system seings;
examples are provided. If you want to run Designer using a different locale,
set your system to the new locale, then restart the machine and run Designer.
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On the Historical Data tab:

Data Range Description

Start Click the calendar buon  and select a date, and then
(optionally) a start time, or type a start date. The default date
and time value is the creation date and time of the simulation.
For any other date, the default time value is 12:00:00 AM.

End Click the calendar buon  and select a date, and then
(optionally) an end time, or type an end date. The default
date value is one month after the creation date and time of the
simulation.

Sample Size The number of samples to retrieve from the BPMS database
for each distribution calculation. The number must be
between 100 and 50,000. The default value is 10,000.

The table on the Historical Data tab in the Advanced Run Seings view contains a list of
all variables defined on the Variables tab for which a Historical Data Source is selected. It
contains the following information about each Variable Name:

Field Description

Process Name The name of the process where the variable is defined. This
value is not editable.

Referenced
Component

The name of the component (that is, the step label) referenced
by the variable. This value is not editable.

Source The Source from which the variable should be loaded:

BPMS. A historical BPMS database. Selected by default
unless the variable is on a resource, in which case the only
option is File.

File. A tab-delimited file. The only available option if the
variable is on a resource.

You can choose to load historical data from either source, but
not both, in a single simulation.

An Extract to BPMS buon becomes available when a Source is specified. For more
information, see "Loading Historical Data from BPMS to Create a Fit Distribution" on
page 54
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webMethods Monitor gathers the required information about frequency, volume,
processing time, and transition distribution. Simulation uses manageable sample records
from this data to compute distributions. The sample data is copied from the Reporting
database to the Simulation database.

About the Optimization Tab
There are many customizations you can apply to optimization simulations; to
accommodate this, the Optimization tab in the Advanced Run Seings view has four
internal tabs:

The Objective tab. For more information, see "About the Objective Tab" on page
32

The Decision Variable Limits tab. For more information, see "About the Decision
Variable Limits Tab" on page 33

The Constraints tab. For more information, see "About the Constraints Tab" on page
33

The Run Options tab. For more information, see "About the Run Options Tab" on page
34

If you are not running an optimization to calculate optimal data for use in simulation,
you do not need to set anything on these tabs.

About the Objective Tab
The Objective tab is where you define the goal, or objective, of your optimization. It is
expressed in the following form:

To <Target> the <Optimization Statistic> <Target Value>

where each variable is defined by the fields on the tab. For example, you might want to
minimize (Target) the average (Optimization Statistic) queue wait time (Target Value). Select
the object values from the following:

Field Description

Target The action you want to take on the Optimization Statistic
of the Target Value. You can choose Maximize (default) or
Minimize.

Optimization Statistic The operator to apply to the Target. You can choose Average
(default), Maximum, Minimum, or Standard Deviation.

Target Value The specific value you want to optimize.

Expand the list and select from Resources, Decision Variables,
and Processes. Then select a type and specific target value.
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Field Description
For example, your selection might be Processes > Loan
Process > Queue Wait Time.

About the Decision Variable Limits Tab
Decision variables restrict the aempted values that the simulation engine will use for
your variable inputs. This helps to make the optimization run more efficiently, and
ensure that undesired values are not aempted.

The items in the list on the Decision Variable Limits tab are the variables for which an
Optimized Data Source is selected on the Variables tab in the Advanced Run Seings
view.

Each Decision Variable listed has the following seings:

Field Description

Start Value The starting value for the variable. The variable's default
value is used if you do not set this.

Lower Bound The lowest acceptable value for the variable.

Upper Bound The highest acceptable value for the variable.

Increments The increment by which the variable value is increased. The
default value of 1 is used if you do not set this.

Tip: Set your search increment to larger values for larger
sets. For example, if your Lower Bound is 1 and your
Upper Bound is 20000, you would probably not want to
use an increment of 1 as it could potentially result in
20,000 tests. An increment of 100 would enable your
optimization to run in a more reasonable amount of
time.

Note: After you have configured the seings on the Objective and Decision Variable
Limits tabs, you can run the optimization. However, you can configure
additional seings on the Constraints and Run Options tabs.

About the Constraints Tab
A constraint defines restrictions on the overall behavior of the process that the
optimization should not violate. These restrictions can include process- and step-
level characteristics, as well as resource restrictions. Use constraints to make sure your
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simulation does not make unrealistic assumptions about the process while aempting to
find the proper variable values to achieve your set objective.

A constraint adds detail to the objective. For example, your objective might be to
minimize queue wait time. You can set a constraint to never let the step wait time to be
longer than a given value.

Use the Add and Delete buons to add and delete constraints in the table. Each row in the
table represents a single constraint, and includes the following information:

Field Description

Performance Measure The name of the performance measure to constrain while
optimizing decision variables.

Expand the list and select from Resources, Decision
Variables, and Processes. Then select a type and specific
target value. For example, your selection might be
Processes > Loan Process > Queue Wait Time.

Optimization Statistic The operator to apply to the Performance Measure.

You can choose Average, Maximum (default), Minimum, or
Standard Deviation.

Lower Bound The lowest acceptable value for the variable.

Upper Bound The highest acceptable value for the variable.

The Add Expression buon opens the Constraint Expression Builder window, where
you can use logical expressions to define a complex constraint expression. For more
information, see "Building a Constraint Expression" on page 57.

About the Run Options Tab
Run options enable you to fine-tune your simulation optimization runs. A simulation
run is the entire run of the simulation defined by the simulation period defined in the
Run Seings view.

You can set the following:

Field Description

Number of
simulation runs
per iteration

Specifies how many times you want to repeat the simulation
for each simulation optimization during a single iteration.
The default is 1.

For example, suppose you configure your Run Seings to run
the simulation for a month. If you set the Number of simulations
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Field Description
per iteration to 10, and set the Maximum number of iterations to 10,
you would run that simulation 100 times.

Note: Each simulation run may produce slightly different
results, particularly when a process contains transition
splits and a distribution function is used to determine
the processing path. When there are different results,
Designer averages the results of the simulation runs.

Maximum number
of iterations

Specifies the maximum number of optimization iterations you
want to run. The default is 100. You can see this information
in real time in the progress bar of the Optimization Statistics
view.

Automatic stop Specifies if you want your optimization to stop automatically
when all values have been tried or when a value is found
that is within the set precision. The check box is selected by
default.

Precision Specifies how precise, or how close to your defined objective,
you want your optimization value to be. The default is 0.001.

Run Optimization Click Run Optimization when you are ready to run your
optimization. The buon name changes to Terminate
Optimization while an optimization is running.

The larger the Number of simulation runs per iteration and the Maximum number of iterations
values are, the more opportunity the engine has to find the best possible values for the
variables based on the target objective you set. However, the larger these numbers are,
the longer your optimization takes to run.

About the Statistics View
The  Statistics view appears in the Process Simulation perspective. You use the
Statistics view to observe the performance of a simulation in progress. Select a step in
the simulation to see statistics on it, or click the canvas to see statistics on the overall
simulation.

Designer also displays statistics in the simulation editor when you run a simulation with
animation. See "Step Gauges and Statistics" on page 93.

If you close the Statistics view and want to reopen it, click Window > Show View >
Statistics.

Statistics displayed for the overall simulation include:
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TOTAL PROCESS INSTANCES  

Completed Instances Instances of the process that are
completed.

Created Instances Instances of the process that are
created.

Active Instances Instances of the process that are active.

TIME (AVERAGE)  

Processing Time Processing time of steps per process
instance.

Wait Time Wait time of steps per process instance.

Process Cycle Time Process instance duration.

COSTS (AVERAGE)  

 Cost of steps per process instance.

Note: Costs are expressed in the value set
for Currency Name on the Statistics tab
in the Run Seings view.

Statistics displayed for a selected activity (step) include:

Field Description

<Step Label>  

Queued Instances of this step that are queued.

Active instances of this step that are active.

Completed Instances of this step that are
completed.



M
Odd Header

About Process Simulation

webMethods BPM Process Simulation Help Version 9.8 37

Field Description

ACTIVITY TIME  

Processing Time Average Processing Time / Instance.

Maximum Processing Time / Instance.

Minimum Processing Time / Instance.

Processing time is the time it takes for
a step to act upon a document.

Wait Time Average Wait Time / Instance

Maximum Wait Time / Instance

Minimum Wait Time / Instance

Wait time is the time a document waits
to be acted upon and processed.

Cycle Time Average Cycle Time / Instance

Maximum Cycle Time / Instance

Minimum Cycle Time / Instance

Cycle time is the time it takes for the
step to run, including wait time and
processing time.

RESOURCE UTILIZATION  

Resource Name Resource Used

Average Usage / Instance

Maximum Usage / Instance

Minimum Usage / Instance

Period Cost

Total Resource Cost

Note: The Cost Period Frequency on the
Statistics tab in the Run Seings
view determines the Period Cost,
and informs the Total Resource Cost.
For example, if you set a Cost Period
Frequency of 1 week, and run a
simulation for 1 month, Designer
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Field Description
displays 4 Period Costs before the
Total Resource Cost.

Tip: The Total Resource Cost may show
zero (0) if the Simulation Period is
not at least as long as the Cost
Period Frequency, or if you stop the
simulation before it reaches the
Cost Period Frequency. For example,
if you set a simulation to run for a
month with a weekly cost period
frequency, but stop it after 5 days,
no cost period elapses, and the total
resource cost is shown as zero. The
Total Resource Cost has not had
enough time to aggregate, so the
value is shown as zero (0). Similarly,
if you set a simulation to run for
5 days with a weekly cost period
frequency, no cost period will elapse
even if you run the simulation all the
way to the end.

TOTAL ACTIVTY COST  

 Total cost of all resources used on
the step, expressed in value set for
Currency Name on the Statistics tab in
the Run Seings view.

ACTIVITY THRESHOLDS  

 Processing Time Threshold

Queue Threshold

Queue Wait Time Threshold

Cost Threshold

Note: Step times reflect the average time a step took from start to finish (cycle), the
time it spent on execution (processing), and the time it spent in waiting for
resources (queued). These step times have no relation to process instances
and, depending on the model, steps could be running concurrently (in splits);
repeated (in loops); or skipped (in branch). Therefore, you should not expect
to add up step times to determine a process time. Process average times
account for all instances created, including active instances. Average process
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cycle time - average process processing time = average process wait time.
Process cycle time is simulation time over created instances, while processing
time is an aggregate of all step processing time over created instances.

About the Optimize Statistics View
The Optimize Statistics view displays statistics that are relevant specifically to
optimizations. It presents information in real time during your simulation run about the
progress being made toward your set objective.

You can run an optimization directly from the Optimize Statistics view by clicking the
 Run Optimization buon in the view toolbar.

If you close the Optimize Statistics view and want to reopen it, click Window > Show View
> Optimize Statistics.

The Optimize Statistics view provides the following information:

Field Description

Progress of Objective  

Progress

(Number of Iterations)

Iterations of the of the simulation that are completed.

The total number of iterations is set with Maximum number
of iterations in Advanced Run Settings > Optimization > Run
Options).

Current  

Status The current status of the simulation. It could be running,
aborted (the Optimize engine encountered an error and
stopped it automatically), infeasible, stopped (manually
stopped by selecting Terminate Optimization), or completed
(the optimization ran all of the iterations as configured
and stopped automatically). In the case of infeasible
simulations, it could abort (aborted infeasible); stop
(stopped infeasible); or complete (completed infeasible) as
a result.

Iteration The number of the current iteration.

Objective Value The current result of the set optimization objective.

For example, if the objective is to minimize total resource
cost, then the objective value is the calculated minimum
total resource cost for the current optimization.
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Field Description

Objective Statement of the objective as configured (set in Advanced
Run Settings > Optimization > Objective).

Termination Reason The reason the simulation stopped.

Summary  

Best Objective  

Iteration The iteration run number that produced the best objective.

Feasible Is the objective feasible? True or False.

Objective Value The most optimal optimization objective value as
determined by the optimization.

The result is entirely dependent on the optimization
configuration. The best value may be zero (0) if that is
what the engine determines.

The Objective Value field is empty when a simulation is not
running, as there is no iteration value to report.

Decision Variable  

Name The name of each variable with an Optimized data source.

Best The best value of those that have been tried so far.

Current The current value being tried.

Constraint Variable  

Name The name of each constraint variable.

Best The best value of those that have been tried so far.

Current The current value being tried.

Expression  
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Field Description

Name The name of each expression constraint.

Best The best value of those that have been tried so far.

You can expand the expression constraint to display the
expression string and additional details about it. The best
value is displayed for each line.

Current The current value being tried.

You can expand the expression constraint to display the
expression string and additional details about it. The
current value is displayed for each line.
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Working with a Process Simulation
You can create a simulation:

Directly from an existing process that is open in the process editor.

By creating a process simulation file.

In both cases, you can modify the simulation in these ways:

Add more processes

Remove processes

Update the existing processes

Change resource availability and usage

Change run seings (including variables, historical data, and optimized data)

Change step scenarios

Note: You do not need to create separate simulations exclusively for extracting
historical data or performing optimization; when configured, any simulation
can utilize the historical data or optimization features.

Simulating a process involves the following actions:

To do this... See this information...

1. Create a process ”Creating Processes” in webMethods BPM Process
Development Help

2. Create a simulation file "Creating a Process Simulation from an Open
Process" on page 45

"Creating a Process Simulation File" on page
46

3. Configure the simulation "Configuring Process Simulation Preferences" on
page 11

"Configuring a Process Simulation" on page
51

"Configuring Process Simulation Properties" on
page 57

"About the Resources View" on page 15

"About the Run Seings View" on page 24
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To do this... See this information...

"About the Advanced Run Seings View" on page
27

4. Configure step scenarios "Configuring a Step Simulation" on page 58

5. Run the simulation "Running a Process Simulation " on page 68

6. Interpret the results "About the Statistics View" on page 35

"About the Optimize Statistics View" on page 39

" Process Simulation Reporting" on page 69

7. Repeat steps 3-6 "Updating a Simulation from a Process" on page
48

Creating a Process Simulation from an Open Process
You can create a process simulation directly from an existing process that is open in the
process editor, and optionally add additional processes to it.

Note: You can also create a process simulation file without having a process open in
the editor. For more information, see "Creating a Process Simulation File" on
page 46.

To create a process simulation from an open process

1. In Designer, ensure that the process you want to work with is open in the process
editor, and that the editor has focus.

2. Click the Simulate Process buon on the main toolbar.

Tip: You can use the following keyboard shortcut: ALT+S.

Note: If it is not possible to create a simulation from the process, Designer
displays the Not Applicable for Simulation dialog box, which describes
the reason or reasons the process cannot be simulated. You can modify the
process according to the instructions, and then try again until Designer
can create a simulation. There are two cases in particular that cannot
be simulated: processes with no start step (that can start a new process
instance), and processes that contain cyclical graphs (that is, a transition
to a previously executed step). In the laer case, use a subprocess loop
instead.
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3. If it is possible to create a simulation from the process, the Create a Simulation
wizard appears. The default selection is Create a new simulation and add process <your
process name>.

4. Click Next to select Create a new simulation and add process <your process name>.

5. Enter, modify, or select the information in the following fields:

Simulation Name (pre-populated with the current process name)

Description (not pre-populated; optional)

Select Project (pre-populated with the current project name)

6. If you want to add additional existing processes to the simulation, click Next; the
Add Processes panel appears. Select the check boxes corresponding to the processes
you want to add. A process can be included in a given simulation file only once;
if you want to create different scenarios for a process, you must create multiple
simulation files.

Note: Designer will not allow you to add processes that it cannot simulate.

7. Click Finish to create the simulation file; the New Simulation Created dialog box
appears. This dialog box also includes reminders that you must configure the
resources, step scenarios, and run seings of the simulation. For more information,
see "Configuring a Process Simulation" on page 51.

8. Click OK to open the simulation file.

Note: When you open a simulation file, Designer can automatically switch to the
Simulation perspective, or prompt you to do so. See "Configuring Process
Simulation Preferences" on page 11.

For more information about working with processes, see ”Process Development Help”
in webMethods BPM Process Development Help.

Creating a Process Simulation File
You can create a process simulation file directly, without having an open process.

Note: You can create a process simulation from a process that is open in the process
editor, and optionally add additional processes to it. For more information,
see "Creating a Process Simulation from an Open Process" on page 45.

To create a process simulation file and add processes to it

1. In Designer, in any perspective (including Process Simulation), do one of the
following:

Click File > New > Simulation

Right-click Simulations in the Solutions view and click  New Simulation.
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2. In the Create a Simulation wizard, enter or select the information in the following
fields:

Simulation Name

Description (optional)

Select Project

3. Click Next.

4. In the Add Processes panel, select the check boxes that correspond to the processes
you want to add to the simulation. A process can be included in a given simulation
file only once; if you want to create different scenarios for a process, you must create
multiple simulation files.

Note: Designer will not allow you to add processes that it cannot simulate.

5. Click Finish to create the simulation file. Designer displays the New Simulation
Created dialog box. This dialog box also includes reminders that you must configure
the resources, step scenarios, and run seings of the simulation. See "Configuring a
Process Simulation" on page 51.

6. Click OK to open the simulation file.

Note: When you open a simulation file, Designer can automatically switch to the
Simulation perspective, or prompt you to do so. See "Configuring Process
Simulation Preferences" on page 11.

For more information about working with processes, see ”Process Development Help”
in webMethods BPM Process Development Help.

Adding a Process to a Simulation
After you create a simulation file, you can add one or more processes to it.

To add a process to a simulation file

1. In Designer, ensure that the simulation you want to work with is open in the
simulation editor, and that the editor has focus.

Note: When you open a simulation file, Designer can automatically switch to the
Simulation perspective, or prompt you to do so. See "Configuring Process
Simulation Preferences" on page 11.

2. Open or switch to the Outline view.

3. Click Add Process.

4. In the Add Processes dialog box, select the check boxes that correspond to the
processes you want to add to the simulation. A process can be included in a given
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simulation file only once; if you want to create different scenarios for a process, you
must create multiple simulation files.

Note: Designer will not allow you to add processes that it cannot simulate.

5. Click Finish to add the process.

Removing a Process from a Simulation
You can remove one or more processes from a simulation.

Note: You cannot undo the removal of a process from a simulation.

Note: Designer does not prevent you from removing all processes from a
simulation, but you cannot run a simulation that contains no processes.

To remove a process from a simulation file

1. In Designer, ensure that the simulation you want to work with is open in the
simulation editor, and that the editor has focus.

2. Expand the top-level simulation node to view the processes included in the
simulation.

3. Select the process you want to remove (hold down the CTRL key to select multiple
processes).

4. Click Remove Process. Designer prompts you to confirm the action, displaying the
name of the process to remove.

5. Click Yes.

Updating a Simulation from a Process
Use this procedure when you want to update a simulation by adding a process, or by
applying changes you have made to a single process that already exists in a simulation.
You can also update all of the processes in a simulation at the same time; for more
information, see "Updating a Simulation from the Outline View" on page 49.

To update an process simulation from a process

1. In Designer, ensure that the process you want to work with is open in the process
editor, and that the editor has focus.

2. Click the Simulate Process buon on the main toolbar.

Tip: You can use the following keyboard shortcut: ALT+S.

Note: If you are adding the process, and it is not possible to create a simulation
from the process, Designer displays the Not Applicable for Simulation
dialog box, which describes the reason or reasons the process cannot
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be simulated. You can modify the process according to the instructions,
and then try again until Designer can create a simulation. There are two
cases in particular that cannot be simulated: processes with no start step
(that can start a new process instance), and processes that contain cyclical
graphs (that is, a transition to a previously executed step). In the laer
case, use a subprocess loop instead.

3. If it is possible to create a simulation from the process, Designer displays the Create a
Simulation wizard.

4. Click Update an existing simulation with the process <your process name>.

5. Click Next to select the simulation that you want to update, either by adding the
process or by applying any changes you have made to an existing process.

6. Click Finish. Designer displays the Simulation successfully updated dialog box.

7. Click OK. Designer displays the updated simulation.

Updating a Simulation from the Outline View
Use this procedure when you want to update all of the processes in a simulation at the
same time; this applies any changes you have made to the processes in the simulation.

To update an process simulation from the Outline view

1. In Designer, ensure that the simulation you want to work with is open in the
simulation editor, and that the editor has focus.

Tip: You can also update one or more processes in an existing simulation
using the Outline view. Open the simulation file you want to update in
the simulation editor, open the Outline view, and then click Refresh
Processes.

2. Open or switch to the Outline view.

3. Click Refresh Processes. Designer prompts you to confirm the action, displaying
the name of the processes to update.

4. Click OK. The processes in the simulation are updated to match the current state of
the process models in Designer.

Importing a Process Simulation File
You can import an existing Designer process simulation file into an existing process
project.

To import a Designer process simulation file

1. In Designer: File > Import >>  Simulation File.
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2. Click Next.

3. In the Process File Import Wizard, click Browse to select a .simulation file to
import.

4. Select the target Process Project from the list.

5. Click Finish.

Exporting a Process Simulation File
You can export a process simulation file and save it as a .simulation file.

To import a Designer process simulation file

1. In Designer: File > Import >>  Simulation File.

2. Click Next.

3. In the Process File Import Wizard, click Browse to select a .simulation file to
import.

4. Select the target Process Project from the list.

5. Click Finish.

Working with a Process Simulation in the Solutions View
Using the Solutions view, you can perform the following actions for process simulations:

To... Take this action in the Solutions view...

Open a process simulation in the
simulation editor

Right-click a  simulation and click
Open, or double-click the simulation.

View the file in your workspace that
correspond to a process simulation

Right-click a  simulation and click
Show Files.

Designer displays the  Navigator
view and highlights the file associated
with the simulation.

Refresh the contents of a process
simulation

Right-click a  simulation and click 
Refresh.

Note: Process simulations do not have references or dependencies.

For more information about working with processes, see ”Process Development Help”
in webMethods BPM Process Development Help.
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Configuring a Process Simulation
Before you can run a process simulation, you must configure a number of seings,
including the resources used by the process as well as the behavior of different
steps in the process. With the exception of Process Simulation preferences, all of the
configuration work must be done with the simulation file open in the simulation editor.

Note: You do not need to create separate simulations exclusively for extracting
historical data or performing optimization; when configured, any simulation
can utilize the historical data or optimization features.

To configure... Follow these procedures...

Processes in a
simulation

To add processes to simulations, see "Adding a Process to a
Simulation" on page 47.

To remove processes from simulations, see "Removing a
Process from a Simulation" on page 48.

To update processes in simulations, see "Updating a
Simulation from a Process" on page 48.

Process simulation
default seings

Process simulation default seings are configured in
Process Simulation preferences, and control enabling
animation recording for playback, automatic perspective
switching, and step gauge type.

See "Configuring Process Simulation Preferences" on page
11 and "Step Gauges and Statistics" on page 93.

Process simulation
resources

Process simulation resources include the Resource and Cost
pages in the Properties view for each resource configured in
the Resources view.

See "About the Resources View" on page 15.

Process simulation
run seings

Process simulation run seings include the Run Settings and
Statistics tabs in the Run Seings view and the Variables,
Historical Data, and Optimization tabs in the Advanced Run
Seings view. The Optimization tab has four tabs of its
own: Objective, Decision Variable Limits, Constraints, and Run
Options.

Tip: If you are not using variables in your simulation, you
do not need to use the Variables tab. If you are not
using historical data in your simulation, you do not



M
Even Header

Working with Process Simulations

webMethods BPM Process Simulation Help Version 9.8 52

To configure... Follow these procedures...
need to use the Historical Data tab. If you are not using
optimizing your simulation, you do not need to use
the Optimization tab.

See "About the Run Seings View" on page 24, "About the
Advanced Run Seings View" on page 27, and " Process
Simulation Performance Seings" on page 96.

Process simulation
properties

Process simulation properties include the General and
Metrics pages in the Properties view.

See "Configuring Process Simulation Properties" on page
57.

Step schedules Step schedules for receive tasks, start events, and
intermediate events include the General, Schedule, and
Transition Distribution pages in the Properties view.

In simulation reports, these are grouped as Start Step
Schedules and Intermediate Step Schedules.

Note: End events have neither schedules nor scenarios.
Likewise send tasks. These are all throwing events.

See "Configuring a Step Schedule" on page 59.

Step scenarios Step scenarios for most activities (tasks other than send and
receive, call activities (including referenced processes), and
subprocesses) include the General, Schedule, and Transition
Distribution pages in the Properties view.

See "Configuring a Step Simulation" on page 58.

Transition
Distribution

Transition distributions for simulated transitions govern
the behavior of the simulation.

See "Configuring a Transition Distribution" on page 62.

Gateways Gateways are specialty transitions, and are configured on
the Transition Distribution page like other transitions.

See "Configuring a Gateway" on page 63.
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Working with Historical Data

Configuring Your System to Use Historical Data

To configure your system to use historical data

Use the following general procedure to configure a historical data fit distribution:

1. Make sure all required database components exist, including the Process Audit,
Staging, and Reporting database components, and configure the Simulation
function to work with the Reporting database component. For complete information
and instructions about database components, see the PDF publication Installing
webMethods and Intelligent Business Operations Products .

2. Configure the process models to log the process and all events, activities, and looped
activities. For instructions, see the PDF publication webMethods Monitor User’s Guide .

3. Install the Simulation database components, and then connect an Integration Server
to them. For instructions, see the PDF publication Installing webMethods and Intelligent
Business Operations Products .

4. Populate the Simulation database components by running the
wm_designer_sim_fitDistribution_pushSimTables service in the WmDesigner package on your
Integration Server to retrieve process audit data that has been aggregated into the
reporting database. The service does not have input parameters.

This service calls three other services (pushSimInstAcccum, pushSimStepAccum, and
pushSimTransAccum) that sample representative data from the Reporting tables and
copy it to the Simulation tables in the Reporting database component. This data
allows you to create distribution functions that you can apply to properties that are
configured as "Variables" in your simulations.

Note: To acquire a meaningful sample of historical data, you must obtain run-
time data over a period of time, not just from a few minutes of running a
process. Software AG recommends that you schedule the service to run
automatically, at specific times or intervals. Doing so minimizes the time
required to process the data. For more information on scheduling services
on Integration Server, see the PDF publication webMethods Integration
Server Administrator’s Guide.

Important: Make sure you have a Minimum Logging Level set at 5-Process and all events,
activities, and looped activities (default) for processes whose data you want to
use in historical data fit distributions. For more information about process
logging, including detailed descriptions of logging levels, see the PDF
publication webMethods Monitor User’s Guide.
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Loading Historical Data from a Tab-Delimited File to Create a Fit Distribution

To load historical data from a tab-delimited file to create a fit distribution

1. In Designer, open the Advanced Run Seings view and click the Historical Data tab.

Tip: You do not need to do anything in the Date Range section if you are
loading historical data from a file.

2. For each Variable Name that has a designation of Historical on the Run Settings tab,
Designer displays the Process Name and the Referenced Component.

3. Select File... as your Source for each Variable Name for which you want to retrieve
historical data.

4. After you select a specific tab-delimited file, Designer displays an informational
message that the file was successfully read and a distribution function was created.
This value is used to populate the distribution value for the variable on the Variables
tab. For example: Uni(0.0,999.979,12).

If Designer cannot successfully read your file and create a distribution function, it
displays the Fit Distribution Failed dialog box, informing you that there was an error
running the fit distribution for the file.

Note: The value loaded is saved, but not the location of the file itself. If you need
to change the file, you must re-select it the same way.

Loading Historical Data from BPMS to Create a Fit Distribution

To load historical data from BPMS to create a fit distribution

1. In Designer, open the Advanced Run Seings view and click the Historical Data tab.

2. Enter the Start and End dates of the BPMS historical data you want to extract.

You can type a date in your system’s date format, or you can click the  calendar
buon to select a date.

3. Enter a number between 100 and 50,000 to represent the Sample Size of the BPMS
historical data you want to extract.

4. For each Variable Name that has a designation of Historical on the Run Settings tab,
Designer displays the Process Name and the Referenced Component.

5. Select BPMS as your Source for each Variable Name for which you want to retrieve
historical data from the database.

6. Click Extract BPMS Data to retrieve historical data for all of the variable names in the
sample that match those in your list.

Important: Extracting BPMS data requires a connection to Integration Server. If
you are not connected, Designer displays a connection error message



M
Odd Header

Working with Process Simulations

webMethods BPM Process Simulation Help Version 9.8 55

and prompts you to connect in Preferences (Window > Preferences
>>Software AG>Integration Servers).

Important: When extracting BPMS data, the back end Integration Server service
looks for all versions of the process that have been run during the
selected time frame. If more than one version has been run, a window
appears asking you to select which version's data to load. Designer allows
historical data for only one version at a time. If the prior version contains
different steps and/or different transitions, Designer loads information
only for items that still exist in the current version. For example, step
instance data for steps no longer in the process model is not loaded.

Working with Optimized Data

Defining Optimization Objectives
Each optimization has a stated objective. It is expressed in the following form:

To <Target> the <Optimization Statistic> <Target Value>

where each variable is defined by the fields on the tab. For example, you might want to
minimize (Target) the average (Optimization Statistic) queue wait time (Target Value).

To define the objective of your optimization

1. In Designer, open the Advanced Run Seings view and click the Optimization tab,
then click the Objective tab.

2. Select a Target.

3. Select an Optimization Statistic.

4. Select a Target Value:

The Resources node contains all of your resources and possible target values.

The Decision Variables node contains a set of possible process-level targets
nested under their simulation names. It also contains all the steps in each
process, with each step having its own set of configurable target values.

5. Save the simulation to apply your seings.

Configuring Decision Variables

To configure a decision variable

1. In Designer, open the Advanced Run Seings view and click the Optimization tab,
then click the Decision Variable Limits tab.

2. In the same row as the Name of the decision variable you want to configure, enter a
value for Lower Bound and a value for Upper Bound.
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3. Optionally, enter a value for Start Value and a value for Increments.

4. Save the simulation to apply your seings.

Adding a Constraint

To add a constraint

1. In Designer, open the Advanced Run Seings view and click the Optimization tab,
then click the Constraints tab.

2. Click Add.

3. Select a Performance Measure from the list.

4. Select an Optimization Statistic from the list.

5. Enter a Lower Bound value and an Upper Bound value.

6. Save the simulation to apply your seings.

Modifying a Constraint

To modify a constraint

1. In Designer, open the Advanced Run Seings view and click the Optimization tab,
then click the Constraints tab.

2. Select the constraint you want to modify.

3. Select a Performance Measure from the list.

4. Select an Optimization Statistic from the list.

5. Enter a Lower Bound and an Upper Bound.

Note: You can modify any or all of the existing fields.

6. Save the simulation to apply your seings.

Deleting a Constraint

To delete a constraint

1. In Designer, open the Advanced Run Seings view and click the Optimization tab,
then click the Constraints tab.

2. Select the constraint you want to delete.

3. Click Delete.

4. Save the simulation to apply your seings.
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Building a Constraint Expression

Important: Constraints can be defined only for Optimized variables, as specified in
the Data Source column on the Variables tab. If the Add Expression buon is
disabled, check to make sure you have an Optimized variable defined.

To build a constraint expression

1. In Designer, open the Advanced Run Seings view and click the Optimization tab,
then click the Constraints tab.

2. Click Add Expression.

3. In the Constraint Expression Builder dialog box, type a Constraint Name.

4. Create a constraint expression as follows doing the following:

Select a variable from the Decision Variables list to add it to the expression string.
This list displays all of the available Optimized variables.

Click the operator and function buons to add them to the expression string.

Type numeric values on your keyboard. Optionally, you can type the variable,
operation, and function terms into the expression field as well.

5. Use the Validate buon to check expression you create.

6. Click OK to save your expression and close the Constraint Expression Builder
window.

To modify or delete a condition expression, see "Modifying or Deleting a Constraint
Expression" on page 57.

Modifying or Deleting a Constraint Expression

To modify or delete a constraint expression

1. In Designer, open the Advanced Run Seings view and click the Optimization tab,
then click the Constraints tab.

2. For the constraint expression you want to work with:

Click Edit to modify the expression.

Click Delete to delete the expression.

3. Save the simulation to apply your changes.

Configuring Process Simulation Properties
Process simulation properties govern the simulation as a whole.
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To configure process simulation properties

1. With the process simulation open in the simulation editor, click the canvas to give
the entire simulation focus.

2. Open or switch to the Properties view.

3. The General page in the Properties view displays the Process Name, Process ID, Version,
Created By, and Description fields from the process on which the simulation is based.
There is nothing to configure on this page; it is for reference purposes only.

4. On the Metrics page in the Properties view, configure the following:

Field Description

Enable Threshold Select this check box to enable threshold violation
warnings during simulation animation and in the
Simulation report (Potential Bolenecks).

Not selected by default.

Important: Only enabled thresholds (for a process or a step)
are examined. You must set the threshold and
enable it.

Processing Time
Threshold

Specifies an average processing time; when this value is
exceeded, a notification appears in the simulation report.

Hours Specifies the unit of time used to measure the Processing
Time Threshold

Default is Hours. You can also select Milliseconds,
Seconds, Minutes, Days, Weeks, Months, and Years.

Cost Threshold Specifies an average cost; when this value is exceeded, a
notification appears in the simulation report.

The Currency Name is set on the Statistics tab in the Run
Seings view. See "About the Run Seings View" on
page 24.

Configuring a Step Simulation
Step scenarios, schedules, and transition distributions govern each step in a process
simulation. You can configure them to behave differently in order to find your most
efficient distribution, or to reach a different goal with your process. There are differences
in configuring different step types:
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Activities (tasks with the exceptions of send and receive tasks, call activities
(including referenced processes), and subprocesses) have step scenario configuration
pages in the Properties view.

Receive tasks and start events (start message, start signal, start none), send tasks,
and end events do not require step scenario configuration other than for outbound
transitions.

Step schedules dictate when start and intermediate events occur and when start and
intermediate (join) receive tasks receive.

Transition distribution allows you to specify just what portion of the pipeline goes
where at a split or a join.

Gateways are made of splits and joins. Like other splits and joins, their behavior is
configured on the Transition Distribution page in the Properties view of the step.

For more information, see these topics:

"Configuring a Step Schedule" on page 59

"Configuring a Step Scenario" on page 61

"Configuring a Transition Distribution" on page 62

"Configuring a Gateway" on page 63

Configuring a Step Schedule
To configure a step schedule

1. With the process simulation open in the simulation editor, select the start receive
task, intermediate receive task, start event, intermediate message event, or
intermediate signal event you want to configure.

2. Open or switch to the Properties view.

3. The General page in the Properties view displays the Label, Step ID, and Description
fields from the process on which the simulation is based. There is nothing to
configure on this page; it is for reference purposes only.

4. On the Schedule page in the Properties view of start steps, configure the following in
the Step Schedule section:

Field Description

Quantity Specifies the number of instances to run at the given time
interval (the number of processes will start one right after
another).
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Field Description

You can type a value or click  the browse buon to open
the Quantity window. You can enter a constant or a variable,
or select a distribution:

Click Constant to enter a static numeric value in the Constant
field. This is the same as entering the value in the Quantity
field on the Schedule page of the Properties view.

Click Variable to use historical data or an optimized
variable. Enter a Variable Name and a Default Value. Further
configuration of variables is available on the Variables tab in
the Advanced Run Seings view.

Click Distribution to select a distribution. You can select from
the list and edit the available parameters if you wish.

When you have defined the configuration you want, click
Finish.

For example: you set Quantity to 2 and Time Interval to 30
minutes. When the simulation starts, 2 instances will be
started immediately. After 30 minutes, 2 more instances will
be started. After another 30 minutes, 2 more instances will be
started, and so on.

Note: Extensive descriptions of available distributions are
provided in the selection window and in "Distribution
Reference" on page 19.

Field Description

Time Interval Specifies the time period at which the receive step runs (that
is, the amount of time between the Quantity of processes
started).

You can type a value or click  the browse buon to open
the Time Interval window. You can enter a constant or a
variable, or select a distribution:

Click Constant to enter a static numeric value in the Constant
field. This is the same as entering the value in the Quantity
field on the Schedule page of the Properties view.

Click Variable to use historical data or an optimized
variable. Enter a Variable Name and a Default Value. Further
configuration of variables is available on the Variables tab in
the Advanced Run Seings view.
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Field Description

Click Distribution to select a distribution. You can select from
the list and edit the available parameters if you wish.

When you have defined the configuration you want, click
Finish.

For example: you set Quantity to 2 and Time Interval to 30
minutes. When the simulation starts, 2 instances will be
started immediately. After 30 minutes, 2 more instances will
be started. After another 30 minutes, 2 more instances will be
started, and so on.

Note: Extensive descriptions of available distributions are
provided in the selection window and in "Distribution
Reference" on page 19.

Hours Specifies the unit of time used to measure the Time Interval

Default is Hours. You can also select Milliseconds, Seconds,
Minutes, Days, Weeks, Months, and Years.

5. On the Schedule page in the Properties view of intermediate steps, configure the
following in the Step Schedule section:

Field Description

Delay Time Specifies the amount of time the step waits to run

Hours Specifies the unit of time used to measure the Delay Time

Default is Hours. You can also select Milliseconds, Seconds,
Minutes, Days, Weeks, Months, and Years.

Start Delay
Timer

Start the Delay Time countdown when the specified condition
is met

Configuring a Step Scenario
You configure step scenarios for most all activity steps. Send and receive tasks are the
exceptions. Besides those, all tasks, call activities (including referenced processes), and
subprocesses have configurable step scenarios.
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To configure a step scenario

1. With the process simulation open in the simulation editor, select the step you want
to configure.

2. Open or switch to the Properties view.

3. The General page in the Properties view displays the Label, Step ID, and Description
fields from the process on which the simulation is based. There is nothing to
configure on this page; it is for reference purposes only.

4. On the Scenario page in the Properties view of the subprocess step, specify the
number of times you want the subprocess to execute in the Loop Count field.

Configuring a Transition Distribution
To configure a transition distribution

1. With the process simulation open in the simulation editor, select the step an
outbound transition you want to configure.

2. Open or switch to the Properties view.

3. The General page in the Properties view displays the Label, Step ID, and Description
fields from the process on which the simulation is based. There is nothing to
configure on this page; it is for reference purposes only.

4. On the Transition Distribution page in the Properties view of steps with outbound
transitions, configure the following:

Click the Transition Distribution page. This defines the Probability Percentage that
transitions from this step make to target steps. Select from the following:

Field Description

All Transitions The transition to each target step is made each time (100%
probability).

This is the default selection.

Even
Probability

The transition to each target step is made an equal
percentage of the time.

For example: if there are 2 target steps, each one has a
50% probability; if there are 4 target steps, each one has a
25% probability.

Custom You can define the transition probability percentages to
the target steps in any way you like.
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Field Description

To modify the table, you can click Add Row and Remove
Row, and select percentages to modify them. To change a
Yes or No, click it to toggle to the value.

Variable You can select a variable probability from historical data.

Note: Transition distribution cannot be optimized, and has
no default value. If you try to select an optimized
data source for a transition distribution, you will
get an error informing you that an optimized data
source is invalid.

For each row in the table, your selections appear in a Probability Percentage column, and
subsequent columns with the target step label as the column name. If the target step
labels are identical, the step ID is applied.

Configuring a Gateway
Gateways are made of splits and joins. In a process simulation, you configure gateway
behavior in the Process Simulation perspective. Configuring a gateway involves the
Transition Distribution page in the Properties view.

Process Simulation supports AND and OR joins only.

For AND gateways, a converging AND join on the gateway itself requires both
transitions to pass through the gateway.

For OR gateways (Inclusive, Exclusive, and Complex), you must configure the Transition
Distribution for both the upstream step and the gateway itself in order to get expected
results.

Tip: Though Process Simulation does not offer an XOR (Unsynchronized OR)
join option, you can create XOR behavior by configuring the transition
distribution as a 70-30 split. In a converging gateway, 70% come from
upstream Path A, and 30% come from upstream Path B. It works the same
way in a diverging gateway, except the 70-30 split is going out of the gateway,
downstream, to new targets.

To configure a gateway for simulation

On the Transition Distribution page in the Properties view of steps with outbound
transitions, including the gateway itself configure the following:

Click the Transition Distribution page. This defines the Probability Percentage that transitions
make from this step to target steps. Select from the following:
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Field Description

All Transitions The transition to each target step is made each time (100%
probability).

This is the default selection.

Even
Probability

The transition to each target step is made an equal percentage of
the time.

For example: if there are 2 target steps, each one has a 50%
probability; if there are 4 target steps, each one has a 25%
probability.

Custom You can define the transition probability percentages to the target
steps in any way you like.

To modify the table, you can click Add Row and Remove Row, and
select percentages to modify them. To change a Yes or No, click it
to toggle to the value.

Variable You can select a variable probability from historical data.

Note: Transition distribution cannot be optimized, and has no
default value. If you try to select an optimized data source
for a transition distribution, you will get an error informing
you that an optimized data source is invalid.

Diverging inclusive or exclusive gateway:

Set All Transitions on the gateway step. All transitions must complete for the process
simulation to complete.

Set an exclusive distribution (50% to one target step and 50% to another target step)
on the gateway step. Either transition completing completes the process simulation.

Converging inclusive or exclusive gateway:

Set All Transitions on the upstream step. All transitions must pass through the
gateway and reach the target step for the process simulation to complete.

Set an exclusive distribution (50% to one target step and 50% to another target step)
on the upstream step. Either transition passing through the gateway and reaching
the target step completes the simulation.

Converging parallel gateway:

Set All Transitions on the upstream step. All transitions must reach the gateway for
the AND join to be satisfied.
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Important: If you set the transition distribution from the upstream step to anything
other than All Transitions, the AND join at the gateway will never be
satisfied. The process simulation will be marked completed because it has
gone as far as it can go. No counts will show for the gateway step or any
steps downstream from the gateway, because they will never be reached.

Diverging parallel gateway:

Set All Transitions on the gateway step. All transitions must pass through the
gateway and reach the target step for the process simulation to complete.

Set an exclusive distribution (50% to one target step and 50% to another target step)
on the upstream step. Either transition passing through the gateway and reaching
the target step completes the simulation.
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Running a Process Simulation
After you create and configure a process simulation, you can run it to determine the
results of your configuration. If you run it with animation, you can watch its progress
in the simulation editor and generate a report when the simulation has completed.
Alternatively, you can run it without animation and go directly to the report.

To run the simulation file currently open in the simulation editor without animation
and generate a report, click Simulate and report (without animation) on the main
Designer toolbar.

To run the simulation file currently open in the simulation editor without animation
and generate a report, click Simulate and animate on the simulation editor toolbar.

When you click Simulate and animate and start a simulation, the buon changes to
Stop simulation. Click it if you want to stop the simulation before it stops on its own.

Note: If you stop a process simulation before it completes on its own and then run
a report, the report will contain only the results for the time processed before
the stop.

The Simulation duration clock on the simulation editor toolbar displays the elapsed run
time of the process you are simulating.

Designer displays a Threshold Exceeded warning on a gauge when a configured
threshold is exceeded during a simulation. A tooltip provides details on the specific
threshold(s) that have been violated.

When an optimization cannot find a feasible solution, Designer displays a message that
contains details about the specific nature of the limitations encountered.

After you have run a process simulation with animation, Designer keeps the simulation
results as long as the simulation file remains open. The results are displayed in the
simulation editor, in the step gauges and statistics, and in the Statistics view. They are
also available for playback, if you have enabled that preference, and for generating
reports.

Running a new process simulation with animation clears the previous simulation
results. If you want to clear the simulation results and start fresh, or just clear the
simulation results without running a new process simulation, click Clear simulation on
the Process Simulation toolbar. The buon is only available after you have run a process
simulation with animation.

Rearranging Steps in a Simulation
You can move steps in a process simulation; however, the original process model is
unaffected and retains the initial step order.
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Important: In a process simulation, do not move steps from one swimlane to another.

If you update a simulation with the original process model, the steps in the simulation
will be returned to the order shown in the process model. For more information, see:

"Updating a Simulation from a Process" on page 48

"Updating a Simulation from the Outline View" on page 49

For purposes of consistency, you are advised to always rearrange steps in the original
process and then update the simulation. This method ensures your process model and
your simulation are always synchronized.

About Animation Slider Controls
The process simulation editor provides two slider control in the tool bar area:

Note: You can use these slider controls only when playing back a recorded process
simulation file. For more information, see " Process Simulation Recording and
Playback" on page 95.

A Slow-Fast slider. This slider is used only to control the animation speed during
playback.

A Start-End slider. This slider indicates the percentage of the simulation progress for
a running simulation, based on the Period specified in the Run Seings view. If you
stop the simulation before the specified Period has elapsed, the slider stops at that
point. You cannot move the slider while a simulation is running.

Process Simulation Reporting
Designer offers real-time reporting in the form of step gauges and statistics in the
simulation editor. These components are displayed when you run a process simulation
with animation. When the simulation is complete, you can generate a report with the

Save simulation report buon.

Note: The Save simulation report buon is not available until you run a simulation.

You can also run process simulations without animation and generate the report. Click
Simulate and report (without animation) in the main toolbar to run the simulation file

currently open in the simulation editor, without animation, and generate a report.

When you generate a simulation report, Designer prompts you to specify the Report
Format, Report Name, and Report Location. You can also specify the option Designershould
Overwrite if file exists. When the report has been generated, Designer displays a
confirmation message.

You can generate as many reports as you want on a given process simulation — perhaps
reconfiguring, rerunning, and saving generated reports with different names for later
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comparison. Designer can generate simulation reports in .CSV or .XLS format, the laer
supporting the creation of charts, graphs, and HTML export to aid you in interpreting
your results.

Process Simulation Reports
Designer can generate simulation reports in .CSV or .XLS format, the laer supporting
the creation of charts, graphs, and HTML export to aid you in interpreting your results.
The reports are organized into worksheets that comprise a workbook called Simulation
Results.

The worksheets are organized as follows:

"Simulation Results - Process Level" on page 71

"Simulation Results - Activity Level" on page 73

"Simulation Results - Swimlane Level" on page 76

"Simulation Results - Potential Bolenecks" on page 79

"Simulation Results - Simulation Seings" on page 81

"Simulation Results - Optimization Seings" on page 89

"Simulation Results - Optimization Results" on page 91

The top of each worksheet displays the names of the processes included in the
simulation, the Run Seings, and the actual running time. These seings and data
sources are described below.

Field Description

Simulation
Report for
<Simulation
Name>

 

Actual Start
Time

The value configured on the Run Seings page in the Run
Seings view.

Actual End
Time

The value configured on the Run Seings page in the Run
Seings view.

Actual
Duration

The value configured on the Run Seings page in the Run
Seings view.

Simulation
Start Time

The actual time you ran the simulation and generated the report.
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Field Description

Simulation
End Time

The actual time the simulation ended.

Simulation
Duration

The actual duration of the simulation.

Simulation
Processes

The processes included in the report.

Simulation Results - Process Level
The first page of the report is devoted to process level statistics. If there is more than one
process in a simulation, then each process is listed in the Times, Costs, Counts section.
There are no steps or swimlane breakdowns on this page. Resources are reported on
across all processes in the simulation.

On the Process Level worksheet:

Field Description

Simulation
Results -
Activity Level

 

Times, Costs,
Counts

All time values use the unit configured for Simulation Time Unit on
the Statistics tab in the Run Seings view. All cost values use the
unit configured for Currency Name on the Statistics tab in the Run
Seings view.

Processes Each process in the report has its own data.

Cycle Time
Avg

The average time to run a process all the way through, including
wait time and processing time.

Important: If a process model contains parallel processing due to a
split, or if some steps take significantly longer than others
to complete, the Cycle Time can be less than the Processing
Time. This can result in a negative Cycle Time Avg value,
which the Simulation report displays as "Not Available."

Processing
Time Avg

The average amount of time for actual processing activity.
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Field Description

Wait Time Avg The average amount of time each process was running but not
actively working on something.

Completed
Instances Total

The number of instances completed.

Cost in
<Currency
Name> Avg

The average cost.

The Currency Name is configured on the Statistics tab in the Run
Seings view.

Resource
Utilization

The usage of each resource for the entire simulation.

Remember that a simulation can have multiple processes in it.
Resource information for a resource used in multiple processes
represents the entire simulation.

Consumption The usage (consumption) of each resource during the entire
simulation.

Avg The average units consumed of each resource for each process.

Max The maximum units consumed of each resource for each process.

Min The minimum units consumed of this resource for each process.

Total The total number of units consumed of this resource for each
process.

Cost in
<Currency
Name>

The Currency Name is configured on the Statistics tab in the Run
Seings view.

Cost Per Unit Determined by the various cost seings that are applied to a
resource (variable, fixed, usage, etc.) and divided by the number
of resources accessed during any processes that have started
(active state) or completed (started then finished).

Total The total cost for every resource accessed for the entire
simulation for each process.
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Field Description

Utilization The percentage of time each resource was in use (busy), not
in use (idle), or being used in one place while being needed in
another (unavailable).

Idle % The percentage of time the resource was not in use for each
process.

Busy % The percentage of time the resource was in use (actively doing
something) for each process.

Unavailable % The percentage of time the resource was being requested for each
process but was unavailable as it was being used elsewhere.

Simulation Results - Activity Level
If there is more than one process in the simulation, the following information is
provided for each of those processes. The Activity Level worksheet provides results for
each BPMN activity step in the simulation:

Field Description

Simulation Results -
Activity Level

 

Times, Costs, Counts  

Activities A row is created for each BPMN activity step in the
process.

Cycle Time The total amount of time that the activity step waited and
processed (Processing Time + Wait Time).

Avg The average amount of time that the activity step waited
and processed.

Max The maximum amount of time that the activity step waited
and processed.

Min The minimum amount of time that the activity step waited
and processed.
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Field Description

Processing Time The amount of time the activity step was processing
something. Configured as the Processing Time on the
Scenario page in the Properties view of the step.

Avg The average amount of time the activity step was
processing something.

Max The maximum amount of time the activity step was
processing something.

Min The minimum amount of time the activity step was
processing something.

Wait Time The amount of time the activity step waited for a resource
before starting.

Avg The average amount of time the activity step waited for a
resource before starting.

Max The maximum amount of time the activity step waited for
a resource before starting.

Min The minimum amount of time the activity step waited for a
resource before starting.

Completed Instances  

Completed The number of completed instances of the activity step
during the entire simulation.

Cost in <Currency
Name>

The Currency Name is configured on the Statistics tab in the
Run Seings view.

Avg The average cost required by the activity step during the
entire simulation.

Resource Utilization The resources used at this activity step during the entire
simulation.

Activity / Resource A row is created for each activity step and resource in the
process.
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Field Description

Consumption The amount of resources consumed at this activity step
during the entire simulation.

Avg The average amount of a resource consumed at this
activity step during the entire simulation.

Avg not TW The average amount of a resource consumed at this
activity step during the entire simulation, without Time
Weighting (TW).

Note: Resources have time-weighted statistics for the most
part; other statistics, such as those that are step- or
process-related, are observation-based, meaning their
statistics are based on the number of instances that
occurred during the simulation run.

Max The maximum amount of a resource consumed at this
activity step during the entire simulation.

Min The minimum amount of a resource consumed at this
activity step during the entire simulation.

Total The total amount of a resource consumed at this activity
step during the entire simulation.

If more than one type of resource is acquired by an activity
step, the report displays another row.

Cost in <Currency
Name>

The Currency Name is configured on the Statistics tab in the
Run Seings view.

Cost Per Unit The total cost per resource unit for the activity step during
the entire simulation.

Total The total cost for the activity step during the entire
simulation.

Utilization The percentage of time each resource was in use by
the activity step (busy), not in use by the step (idle), or
being used elsewhere while being requested by the step
(unavailable).
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Field Description

Idle % The percentage of time the resource was not in use by the
activity step.

Busy % The percentage of time the resource was in use by the
activity step (actively doing something).

Unavailable % The percentage of time the resource was being requested
by the activity step but was unavailable as it was being
used elsewhere.

Simulation Results - Swimlane Level
This worksheet is present only if swimlanes are used in the simulation. If more than one
process in the simulation contains swimlanes, the following information is provided for
the swimlanes in each of those processes.

On the Swimlane Level worksheet:

Field Description

Simulation Results - Swimlane Level  

Times, Cost, Counts  

Swimlanes A row is created for each swimlane in the
process.

Cycle Time The total amount of time that steps in the
swimlane waited and processed (Processing
Time + Wait Time).

Avg The average amount of time that steps in the
swimlane waited and processed.

Max The maximum amount of time that steps in
the swimlane waited and processed.

Min The minimum amount of time that steps in
the swimlane waited and processed.

Processing Time The amount of time steps in the swimlane
did something. Configured as the Processing
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Field Description
Time on the Scenario page in the Properties
view of each step.

Avg The average amount of time steps in the
swimlane did something.

Max The maximum amount of time steps in the
swimlane did something.

Min The minimum amount of time steps in the
swimlane did something.

Wait Time The amount of time steps in the swimlane
waited for a resource before starting.

Avg The average amount of time steps in the
swimlane waited for a resource before
starting.

Max The maximum amount of time steps in
the swimlane waited for a resource before
starting.

Min The minimum amount of time steps in
the swimlane waited for a resource before
starting.

Completed Instances  

Completed The number of completed instances of steps
in the swimlane during the entire simulation.

Costs  

Avg The average cost required by steps in the
swimlane during the entire simulation.

Resource Utilization The resources used by steps in the swimlane
during the entire simulation.

Swimlane / Resource A row is created for each resource used in
each swimlane.
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Field Description

Consumption The amount of resources consumed by steps
in the swimlane during the entire simulation.

Avg The average amount of a resource consumed
by steps in the swimlane during the entire
simulation.

Max The maximum amount of a resource
consumed by steps in the swimlane during
the entire simulation.

Min The minimum amount of a resource
consumed by steps in the swimlane during
the entire simulation.

Total The total amount of a resource consumed
by steps in the swimlane during the entire
simulation.

If more than one type of resource is acquired
by steps in the swimlane, the report displays
another row.

Cost in <Currency Name> The Currency Name is configured on the
Statistics page in the Run Seings view.

Cost Per Unit The total cost per resource unit for steps in
the swimlane during the entire simulation.

Total The total cost for steps in the swimlane
during the entire simulation.

Utilization The percentage of time each resource was in
use by steps in the swimlane (busy), not in
use by steps in the swimlane (idle), or being
used elsewhere while being requested by
steps in the swimlane (unavailable).

Idle % The percentage of time the resource was not
in use by steps in the swimlane.
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Field Description

Busy % The percentage of time the resource was in
use by steps in the swimlane (actively doing
something).

Unavailable % The percentage of time the resource was
being requested by steps in the swimlane
but was unavailable as it was being used
elsewhere.

Simulation Results - Potential Bottlenecks
If there is more than one process in the simulation, the following information is
provided for each of those processes.

On the Potential Bolenecks worksheet:

Field Description

Simulation Results - Potential Bottlenecks  

Processes Provides information for each process
in the simulation. The information on
this page is filtered by enabled process
thresholds.

Processing Time in <Simulation Time Unit> The amount of time it took for
the entire process to process. The
Simulation Time Unit is configured on the
Statistics tab in the Run Seings view.

Threshold The Processing Time Threshold for the
entire process.

Avg The average Processing Time for the
entire process.

Cost in <Currency Name> The cost incurred by the entire process.
The Currency Name is configured on
the Statistics page in the Run Seings
view.
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Field Description

Threshold The CostThreshold for the entire
process.

Avg The average Cost for the entire process.

Activities To be displayed here, an activity
step must have the Enable Thresholds
seing enabled on the Metrics page in
the Properties view, and at least one
of those thresholds must have been
crossed in the simulation.

Processing Time in <Simulation Time Unit> The amount of time the activity step
took to process. The Simulation Time Unit
is configured on the Statistics page in
the Run Seings view.

Threshold The Processing Time Threshold for the
activity step.

Avg The average Processing Time for the
activity step.

Queue Wait Time (in <Simulation Time
Unit>)

The amount of time each activity step
instance waited to be processed. The
Simulation Time Unit is configured on the
Statistics tab in the Run Seings view

Threshold The Queue Wait TimeThreshold for the
activity step.

Avg The average Queue Wait Time for the
activity step.

Queue The number of activity step instances
waiting to be processed.

Threshold The Queue Threshold for the activity
step.

Avg The average Queue for the activity step.
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Field Description

Cost in <Currency Name> The cost incurred by the activity step.
The Currency Name is configured on the
Statistics tab in the Run Seings view.

Threshold The Cost Threshold for the activity step.

Avg The average Cost for the activity step.

Simulation Results - Simulation Settings
If there is more than one process in the simulation, the following information is
provided for each of those processes.

On the Simulation Seings worksheet:

Field Description

Simulation Results - Simulation Settings  

Run Settings  

Simulation Time Unit The frequency at which the simulation
engine sends new update events.
Configured on the Statistics tab in the
Run Seings view. Options are Hours,
Days, Weeks, Months, and Years.

Cost Period Frequency The frequency at which costs are
aggregated. Configured on the
Statistics tab in the Run Seings view.
Options are Weekly, Monthly, Quarterly,
Half-Yearly, and Yearly.

Currency Name The name of the currency used (for
example, dollars or euros).

Update Frequency The frequency at which the simulation
animation updates. Configured on the
Run Settings tab in the Run Seings
view. Options are Hours, Days, Weeks,
Months, and Years.
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Field Description

Simulation Resources  

Resource / Description/ Available Units A row is created for each resource in
the simulation.

Default Value The default value set for the resource
in the <Resource Name> : Available
Units window, accessed from the
Available Units field on the Resource
page in the Properties view of the
resource.

The Default Value displays the Variable
name if a variable name is configured
as the default.

Calculated Value The actual value used if the Default
Value is a Variable.

If the source of the variable is
optimized, the optimized value
obtained by running an optimization is
displayed. If the source of the variable
is historical, a distribution function
value created from a specified tab-
delimited file or a value from historical
data is displayed. If the source of
the variable is default, the default
value configured for the variable is
displayed.

Consumable Whether or not the resource is
consumable. Configured in the
Consumable Resource check box on the
Cost page in the Properties view of the
resource.

Downtime Profile The Downtime Profile configured in the
Downtime Profile field on the Cost page
in the Properties view. Options are No
downtime, Standard shift, and Night shift.

Cost in <Currency Name>  
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Field Description

Fixed Cost per Time Unit  

Default Value The default value set for the resource
in the <Resource Name> : Fixed Cost
window, accessed from the Fixed Cost
field on the Cost page in the Properties
view of the resource.

The Default Value displays the Variable
name if a variable name is configured
as the default.

Calculated Value The actual value used if the Default
Value is a variable.

If the source of the variable is
optimized, the optimized value
obtained by running an optimization is
displayed. If the source of the variable
is historical, a distribution function
value created from a specified tab-
delimited file or a value from historical
data is displayed. If the source of
the variable is default, the default
value configured for the variable is
displayed.

Fixed Cost Time Unit The time unit used to measure the
Fixed Cost. Configured on the Cost page
in the Properties view of the resource.

Variable Cost Per Time Unit  

Default Value The default value set for the (non-
consumable) resource in the <Resource
Name> : Variable Cost window,
accessed from the Variable Cost field on
the Cost page in the Properties view
of the resource. A non-consumable
resource cost is based on a time unit.

The Default Value displays the Variable
name if a variable name is configured
as the default.
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Field Description

Calculated Value The actual value used if the Default
Value is a Variable.

If the source of the variable is
optimized, the optimized value
obtained by running an optimization is
displayed. If the source of the variable
is historical, a distribution function
value created from a specified tab-
delimited file or a value from historical
data is displayed. If the source of
the variable is default, the default
value configured for the variable is
displayed.

Variable Cost Time Unit Time unit by which the Variable Cost is
measured. Configured in the per Period
field on the Cost page in the Properties
view of the resource. Options are:
Milliseconds, Seconds, Minutes, Hours,
Days, Weeks, Months, and Years.

Variable Cost Per Unit (If Consumable
Resource)

The value configured for the
(consumable) resource in the <Resource
Name> : Variable Cost window,
accessed from the Variable Cost field on
the Cost page in the Properties view of
the resource. A consumable resource
cost can be a variable.

Usage Cost  

Default Value The default value set for the resource
in the <Resource Name> : Usage Cost
window, accessed from the Usage Cost
field on the Cost page in the Properties
view of the resource.

The Default Value displays the Variable
name if a variable name is configured
as the default.

Calculated Value The actual value used if the Default
Value is a Variable.
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Field Description

If the source of the variable is
optimized, the optimized value
obtained by running an optimization is
displayed. If the source of the variable
is historical, a distribution function
value created from a specified tab-
delimited file or a value from historical
data is displayed. If the source of
the variable is default, the default
value configured for the variable is
displayed.

Process Thresholds  

Processing Time Threshold Configured in the Processing Time
Threshold field on the Metrics page in
the Properties view of the process.

Unit Time unit by which the Processing Time
Threshold is measured. Options are:
Milliseconds, Seconds, Minutes, Hours,
Days, Weeks, Months, and Years.

Cost Threshold Specifies an average cost; when this
value is exceeded, a notification
appears in the simulation report.
Configured in the Cost Threshold field
on the Metrics page in the Properties
view of the process.

Schedules  

Start Step Schedules Contains an entry for each starting
event in the process.

Event The name of the event step.

Time Interval/Default Value The default value set for the frequency
of input to the step in the <Start
Step Name> : Time Interval window,
accessed from the Time Interval field
on the Schedule page in the Properties
view.
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Field Description

Calculated Value The actual value used if the Default
Value is a variable.

If the source of the variable is
optimized, the optimized value
obtained by running an optimization is
displayed. If the source of the variable
is historical, a distribution function
value created from a specified tab-
delimited file or a value from historical
data is displayed. If the source of
the variable is default, the default
value configured for the variable is
displayed.

Time Unit The time unit by which the Time
Interval is measured. Configured on the
Schedule page in the Properties view of
a start step. Options are: Milliseconds,
Seconds, Minutes, Hours, Days, Weeks,
Months, and Years.

Quantity/Default Value The default value set for the input
to the step in the <Start Step Name> :
Quantity window, accessed from the
Quantity field on the Schedule page in
the Properties view.

Calculated Value The actual value used if the Default
Value is a variable.

If the source of the variable is
optimized, the optimized value
obtained by running an optimization is
displayed. If the source of the variable
is historical, a distribution function
value created from a specified tab-
delimited file or a value from historical
data is displayed. If the source of
the variable is default, the default
value configured for the variable is
displayed.

Transitions Taken The transition(s) taken from this step,
or, the destination of the transition, or,
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Field Description
notice that this is an end step with no
transitions.

Probability Percentage The percentage of probability that the
Step Transitions Taken would occur.
Configured on the Transition Distribution
page in the Properties view of the step.

Distribution Type If a step has multiple transitions, there
are several options: All Transitions,
Even Probability, Custom, or Variable.
A Variable Probability Percentage could
be a distribution function or set from
historical data.

Intermediate Step Schedules This section provides the same
information as the Start Step Schedules
portion of the worksheet, except that
intermediate-type steps are listed.

Step Scenarios Contains an entry for each activity step
in the process.

Activity The name of each activity step in the
process.

Processing Time in <Time Unit>  

Default Value The default value set for the processing
time of the step in the <Step Name> :
Processing Time window, accessed
from the Processing Time field on the
Scenario page in the Properties view of
the step.

Calculated Value The actual value used if the Default
Value is a variable.

If the source of the variable is
optimized, the optimized value
obtained by running an optimization is
displayed. If the source of the variable
is historical, a distribution function
value created from a specified tab-
delimited file or a value from historical
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Field Description
data is displayed. If the source of
the variable is default, the default
value configured for the variable is
displayed.

Time Unit The time unit by which the Processing
Time is measured. Configured on the
Scenario page in the Properties view
of a step. Options are: Milliseconds,
Seconds, Minutes, Hours, Days, Weeks,
Months, and Years.

Processing Time Threshold Configured in the Processing Time
Threshold field on the Metrics page in
the Properties view of the step.

Unit Time unit by which the Processing Time
Threshold is measured. Configured on
the Metrics page in the Properties view
of the step. Options are: Milliseconds,
Seconds, Minutes, Hours, Days, Weeks,
Months, and Years.

Queue Threshold The number of process instances that
can be waiting to be processed at
the step; if this value is exceeded, it
indicates a boleneck and generates a
notification in the simulation report.
Configured in the Queue Threshold field
on the Metrics page in the Properties
view of the step.

Queue Wait Time Threshold The average wait time for process
instances at the step; if this value is
exceeded, a notification appears in the
simulation report. Configured in the
Queue Wait Time Threshold field on the
Metrics page in the Properties view of
the step.

Unit Time unit by which the Queue Wait Time
Threshold is measured. Configured on
the Metrics page in the Properties view
of the step. Options are: Milliseconds,
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Field Description
Seconds, Minutes, Hours, Days, Weeks,
Months, and Years.

Cost Threshold The average cost; when this value is
exceeded, a notification appears in the
simulation report.Configured in the
Cost Threshold field on the Metrics page
in the Properties view of the step.

Simulation Results - Optimization Settings

Tip: Date and time formats are governed by your operating system seings. If
you want to run Designer using a different locale, set your system to the new
locale, then restart the machine and run Designer.

On the Optimization Seings worksheet:

Field Description

Simulation Results - Optimization Settings  

Objective Settings These values are displayed on the
Objective tab of the Optimization page
in the Advanced Run Seings view.
See "Defining Optimization Objectives"
on page 55.

Objective Target Selected Target.

Optimization Selected Optimization.

Target Value Selected Target Value.

Variables These values are displayed on the
Variables page in the Advanced
Run Seings view. See "Configuring
Decision Variables" on page 55.

Variable Name Selected Variable Name.

Referenced Component Selected Referenced Component.
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Field Description

Data Source File or BPMS.

Value Defined Target Value.

Fit Distribution Settings These values are displayed on the
Historical Data page in the Advanced
Run Seings view. See "Configuring
Your System to Use Historical Data" on
page 53.

Start Date Selected Start Date.

End Date Selected End Date.

Sample Size Selected Sample Size.

Fit Distribution Variables These values are displayed on the
Historical Data page in the Advanced
Run Seings view. "Configuring Your
System to Use Historical Data" on page
53.

Name Variable Name.

Process Name Selected Process Name.

Type Selected distribution Type.

Source File or BPMS.

Decision Variable Limits These values are displayed on
the Decision Variables tab on the
Optimization page in the Advanced
Run Seings view. See "Configuring
Decision Variables" on page 55.

Name Defined decision variable Name.

Start Value Optional Start Value.

Lower Bound Defined Lower Bound value.
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Field Description

Upper Bound Defined Upper Bound value.

Increments Optional Increments.

Performance Constraints These values are displayed on the
Constraints tab on the Optimization
page in the Advanced Run Seings
view. See "Configuring Decision
Variables" on page 55.

Performance Measure Selected Performance Measure.

Optimization Statistic Selected Optimization Statistic.

Lower Bound Defined Lower Bound value.

Upper Bound Defined Upper Bound value.

Simulation Results - Optimization Results
The Optimization Results worksheet contains information displayed in the Optimization
Statistics view during an optimization, including the best values returned during the
simulation.

On the Optimization Results worksheet:

Field Description

Simulation Results - Optimization Results  

Best Objective  

Iteration The iteration with the best objective
value.

Feasible True or false: the configured values
and constraints can create a feasible
solution for the input values to the
variables.

Best Value The best objective value.
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Field Description

Variables The decision variables from the
Decision Variables tab on the
Optimization page in the Advanced
Run Seings view. See "Configuring
Decision Variables" on page 55.

Variable Name Defined Variable Name.

Referenced Component Selected Referenced Component.

Data Source File or BPMS.

Best Value The best value based on the variable
input.

Performance Constraints These values are displayed on the
Constraints tab on the Optimization
page in the Advanced Run Seings
view. See "Configuring Decision
Variables" on page 55.

Performance Measure  

Optimization Statistic  

Best Value The best value based on the
performance constraints.

Lower Bound Performance constraints have bounds;
expression constraints do not.

Upper Bound Performance constraints have bounds;
expression constraints do not.

Expression Constraints These values are displayed on the
Constraints tab of the Optimization
page in the Advanced Run Seings
view. See "Configuring Decision
Variables" on page 55.

Name Defined expression Name.
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Field Description

Expression Defined Expression.

Best LHS Performance constraints have bounds;
expression constraints do not. The best
left hand side (LHS) and right hand
side (RHS) based on the expression
constraints are displayed.

Best RHS Performance constraints have bounds;
expression constraints do not. The best
left hand side (LHS) and right hand
side (RHS) based on the expression
constraints are displayed.

Step Gauges and Statistics
When you run a process simulation with animation, real-time statistics are available
with step gauges.

  

  

Designer displays information about the state of each step
as the simulation proceeds. You can configure Process
Simulation preferences to use image gauges or bar chart
gauges. See "Configuring Process Simulation Preferences" on
page 11.

Designer displays the step gauges to the left of each step. The gauges are composites of
graphics representing the following ratios:

Ratio Description

Bottleneck ratio

    

The number of process instances waiting at the
step compared to the number of process instances
waiting AND processing at the step.

On the image gauge: red arc

On the bar chart: red bar
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Ratio Description

Relative efficiency

    

The number of process instances waiting OR
processing at the step compared to the number of
process instances processing.

On the image gauge: blue arc

On the bar chart: blue bar

Completed / status

    

The percentage the step has completed compared
to the number of processes created.

On the image gauge: green bar with black
squares

On the bar chart: green bar

To the right of each step, Designer displays statistics corresponding to the following:

 Color Description

Red The number of processes waiting at the
step.

Blue The number of process instances that are
active (processing or waiting) at the step.

Green The number of times the step has
completed for all process instances that
are running now or have run already.

At the top right of the design canvas, there are three more statistics:

Statistic Description

Completed Instances The number of process instances that have completed.

Created Instances The number of process instances that have been created.

Active Instances The number of process instances that are active (processing
at steps) OR waiting at steps.
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Process Simulation Recording and Playback
If you configure Process Simulation preferences to enable animation recording, Designer
automatically records your simulation when you run it with animation.

When you play back a process simulation, you can use the following buons:

Button Description

Search backwards

Playback simulation

Stop simulation

Search forwards

There is no pause function; if you stop a simulation during playback, the simulation
resets to the beginning.

There are two slider controls:

Slider Control Description

Start - End When you play back a process simulation file, the Start-
End slider indicates the percentage of its progress, based
on the length of the simulation file. You can move the slider
forward and backward in the simulation file while you are
playing a simulation recording.

Slow - Fast When you play back a process simulation file, you can
control the speed at which it runs using the Slow-Fast slider
on the Process Simulation toolbar. Move the slider to the
right to speed up, and to the left to slow down.

Note: Process simulation recordings are available for playback only during the
Designer session in which they are recorded. You must run the simulations
again in another session if you want to play them back again.
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Process Simulation Performance Settings
The following topics contain important information about how you can optimize the
performance of Process Simulation.

Any heuristic method for solving problems cannot guarantee that it will find the optimal
solution. It might find a solution that is only close to the optimal solution, usually
referred to as the best solution; this is why maximizing performance is critical.

Refer to the following topics for relevant factors that directly affect performance:

"Number of Decision Variables" on page 96

"Initial Values" on page 97

"Decision Variable Bounds" on page 97

"Complexity of the Objective" on page 98

"Constraints" on page 98

"Feasibility" on page 99

"Number of Replications and Simulations" on page 99

"Simulation Accuracy" on page 99

"Simulation Speed" on page 100

Number of Decision Variables
The number of decision variables greatly affects Process Simulation performance.
Process Simulation has no physical limit on the number of decision variables that can be
used in any given problem. However, the performance might deteriorate if more than
100 decision variables are used.

Also, as the number of decision variables increases, more simulations are needed to
find high-quality solutions. General guidelines for the minimum number of simulations
required for a given number of decision variables in a problem are:

Number of Variables Minimum Number of Simulations

Less than 10 100

10 - 20 500

20 - 50 2,000

50 - 100 5,000
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You can also take the following actions:

Increase the number of replications to increase accuracy

Rerun the optimization

Another option is to de-select certain decision variables and optimize the remaining
ones. If an optimization has already been run, there might be information available
about which decision variables have the least effect on the objective function. When
one or more decision variables is de-selected and the optimization is rerun, the search
focuses on the remaining (more important) decision variables.

For very large numbers of decision variables, try this procedure:

1. Decrease the number of replication per simulation, at least initially.

2. Run the optimization to get an approximate solution.

3. Set the suggested values to the approximate solution.

4. Further restrict the bounds on the decision variables.

Initial Values
The initial values are the values listed as the Starting Values on the Decision Variables tab.
Initial values are important because the closer they are to the optimal value, the faster
Process Simulation can find an optimal solution. If the initial values are constraint-
infeasible, they are ignored.

For potentially large models with many decision variables, it might be helpful to first
run a simplified version of the optimization to find initial values for the full-scale model.
For example, expected values could be used for some of the random variables in the
model.

Decision Variable Bounds
Process Simulation performance can be significantly improved by selecting meaningful
bounds for the decision variables. Suppose, for example, that the bounds for three
decision variables (X, Y, and Z) are:

0 <= X <= 100

0 <= Y <= 100

0 <= Z <= 100

And in addition to the bounds, the following constraint applies:

10*X + 12*Y + 20*Z <= 200

Although the optimization model is correct, the decision variables bounds are not
meaningful. A beer set of bounds for these decision variables would be:

0 <= X <= 20



M
Even Header

Running Process Simulations

webMethods BPM Process Simulation Help Version 9.8 98

0 <= Y <= 16.667

0 <= Z <= 10

These bounds take into consideration the values of the coefficients and the constraint
limit to determine the maximum value for each decision variable. The new, tighter
bounds result in a more efficient search for the optimal values of the decision variables.
However, this efficiency comes at the expense of missing the optimal solution if it lies
outside the specified bounds.

Complexity of the Objective
A complex objective has a highly nonlinear surface with many local minimum and
maximum points. Process Simulation is designed to find global solutions for all types
of objectives, especially complex objectives. However, for more complex objectives,
generally it is required to run more simulations to find high quality global solutions.

Because only one value can be optimized, complex objectives must be defined within the
model expressions.

Constraints
Constraints can be used to restrict the values of decision variables (model parameters)
by defining relationships among the decision variables; constraints can also restrict the
value of output variables (performance measures).

If a constraint is defined using only decision variables, Process Simulation can eliminate
sets of decision variables values that are constraint-infeasible before it runs the
simulation. Limiting the optimization by defining constraints on decision variables is
extremely time-effective.

If a constraint contains a performance measure, a simulation must be run to determine
whether the suggested solution satisfies the constraint. The search process benefits from
the use of constraints on decision variables and tight bounds on decision variables.
However, performance generally suffers when performance measure constraints are
included in the optimization model for two reasons:

Performance measure constraints are very time-consuming to evaluate, since Process
Simulation must run an entire simulation before determining whether the results are
constraint-infeasible.

To avoid running constraint-infeasible simulations, Process Simulation must identify
the characteristics of solutions likely to be constraint-feasible; this makes the search
more complex and requires more time.

Even though performance measure constraints can greatly decrease the number
of feasible simulations performed during an optimization, performance measure
constraints can focus the search to effectively rule out undesirable solutions. If there
are lots of performance measure constraints that Process Simulation can't easily satisfy,
consider combining the output constraints into one multi-objective function.
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Feasibility
Process Simulation considers finding a feasible solution the highest priority. After it
finds a feasible solution, it then concentrates on finding beer solutions. The fact that a
particular solution may be infeasible does not imply that the problem itself is infeasible.

However, infeasible problems do exist. For example, suppose that in a Job Shop problem
a foreman insists on finding an optimal configuration with the following constraints:

drills + grinders <= 4

drills + grinders >= 5

Clearly, there is no combination that will satisfy both of these constraints.

Or, for this same example, suppose the bounds for a decision variable are:

3 <= saws <= 5

And a constraint is:

saws <= 2

This also results in an infeasible problem. Process Simulation displays an error message
and terminates infeasible optimizations.

Infeasible problems can be made feasible by fixing the inconsistencies of the
relationships modeled by the constraints. Process Simulation detects optimization
models that are constraint-infeasible and reports them.

If a model is constraint-feasible, Process Simulation will always find a feasible solution
and search for the optimal solution (that is, the best solution that satisfies all constraints).

Number of Replications and Simulations
When Process Simulation runs an optimization, it runs a simulation to evaluate each set
of decision variable (model parameter) values. Therefore, the quality of the optimization
results depends on the number of simulations (iterations) and the number of replications
per simulation.

For a set period of time, the number of replications per simulation is inversely related to
the number of simulations; as one increases, the other decreases. Decreasing the number
of replications can help increase the number of simulations.

The more simulations Process Simulation can run, the more sets of values it can
evaluate, and the more likely Process Simulation is to find a solution close to the optimal
solution.

Simulation Accuracy
There are two factors that affect simulation accuracy:
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Number of replications per simulation—for sufficient accuracy, the number of
replications per simulation must be set to the minimum number necessary to obtain
a reliable estimate of the objective function being optimized; this minimum number
is typically found with empirical testing.

Noisiness of the objective—this factor is caused by the probability distributions
used to model the problem's uncertainty. In some cases, Process Simulation might
have trouble discerning the minimum or maximum value. Noisy functions can be
detected by watching for best solutions that seem to "bounce around" from one set of
values to completely different sets of values. To help solve this problem, increase the
number of replications per simulation.

Simulation Speed
Some suggestions for increasing speed include:

Reduce the size of the model (or the duration of the simulation).

Increase the system's RAM.

Reduce the number of uncertain elements in the simulation.

Close other applications.


	Table of Contents
	About this Guide
	Document Conventions
	Online Information

	About Process Simulation
	Simulating a Process
	About Simulation Information
	About Scenarios
	About Resources
	About Costs
	Configuring Process Simulation Preferences

	About the Process Simulation Perspective
	About Process Simulation Views
	About the Resources View
	Distribution Reference
	About the Run Settings View
	About the Advanced Run Settings View
	About the Variables Tab
	About Variables
	About the Historical Data Tab
	About the Optimization Tab
	About the Objective Tab
	About the Decision Variable Limits Tab
	About the Constraints Tab
	About the Run Options Tab

	About the Statistics View
	About the Optimize Statistics View


	Working with Process Simulations
	Working with a Process Simulation
	Creating a Process Simulation from an Open Process
	Creating a Process Simulation File
	Adding a Process to a Simulation
	Removing a Process from a Simulation
	Updating a Simulation from a Process
	Updating a Simulation from the Outline View
	Importing a Process Simulation File
	Exporting a Process Simulation File
	Working with a Process Simulation in the Solutions View

	Configuring a Process Simulation
	Working with Historical Data
	Configuring Your System to Use Historical Data
	Loading Historical Data from a Tab-Delimited File to Create a Fit Distribution
	Loading Historical Data from BPMS to Create a Fit Distribution

	Working with Optimized Data
	Defining Optimization Objectives
	Configuring Decision Variables
	Adding a Constraint
	Modifying a Constraint
	Deleting a Constraint
	Building a Constraint Expression
	Modifying or Deleting a Constraint Expression

	Configuring Process Simulation Properties
	Configuring a Step Simulation
	Configuring a Step Schedule
	Configuring a Step Scenario
	Configuring a Transition Distribution
	Configuring a Gateway


	Running Process Simulations
	Running a Process Simulation
	Rearranging Steps in a Simulation
	About Animation Slider Controls

	Process Simulation Reporting
	Process Simulation Reports
	Simulation Results - Process Level
	Simulation Results - Activity Level
	Simulation Results - Swimlane Level
	Simulation Results - Potential Bottlenecks
	Simulation Results - Simulation Settings
	Simulation Results - Optimization Settings
	Simulation Results - Optimization Results

	Step Gauges and Statistics

	Process Simulation Recording and Playback
	Process Simulation Performance Settings
	Number of Decision Variables
	Initial Values
	Decision Variable Bounds
	Complexity of the Objective
	Constraints
	Feasibility
	Number of Replications and Simulations
	Simulation Accuracy
	Simulation Speed



